BOISE STATE UNIVERSITY GRADUATE COLLEGE STANDARDS
AND GUIDELINES FOR THESES AND DISSERTATIONS

Boise State University
Graduate College

Summer 2014
The purpose of this document is to provide students and faculty with a clear understanding of the thesis/dissertation process and to provide clear standards and guidelines for formatting and creating a thesis/dissertation. Additionally, this document serves as an example of the formatting standards expected of students’ theses/dissertations.

Please see the current Boise State University Graduate Catalog (http://graduatecatalog.boisestate.edu/) for additional information regarding official Graduate College policies and regulations, as well as college, department, and program details.

If you have questions or concerns regarding the thesis/dissertation process or guidelines not addressed in this handbook or the Graduate Catalog, please contact the Graduate College Thesis and Dissertation Office via phone at 208-426-3604 or e-mail at jodichilson@boisestate.edu.

The Thesis and Dissertation Office is located on the third floor of Riverfront Hall in room 307D.
TABLE OF CONTENTS

ABSTRACT ........................................................................................................................................ iii

LIST OF TABLES ............................................................................................................................ x

LIST OF FIGURES ....................................................................................................................... xi

CHAPTER ONE: THESIS AND DISSERTATION PROCESS ........................................................ 1

New Changes: ScholarWorks .................................................................................................... 1

Thesis and Dissertation Process: Paperless! ............................................................................. 1

Copies of Thesis/Dissertation for Binding ............................................................................. 1

Summary of Entire Thesis/Dissertation Process .................................................................... 2

Overview .................................................................................................................................... 2

Detailed ....................................................................................................................................... 3

Thesis/Dissertation: Required Forms and Instructions ......................................................... 9

Forms Filled Out Prior to Defense .......................................................................................... 9

Forms Shortly After Defense and After Obtaining Final Reading Approval from Advisor ... 9

Dissertation Process ................................................................................................................ 10

Overview .................................................................................................................................... 10

General Deadlines: Thesis and Dissertation ......................................................................... 11

On-Campus Services for Students .......................................................................................... 14

The Writing Center .................................................................................................................. 14

Albertsons Library .................................................................................................................... 15
# CHAPTER TWO: THESIS/DISSERTATION ELEMENTS, STANDARDS, AND GUIDELINES

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>17</td>
</tr>
<tr>
<td>Institutional Review Board (IRB) Approval</td>
<td>18</td>
</tr>
<tr>
<td>Institutional Animal Care and Use Committee (IACUC) Approval</td>
<td>18</td>
</tr>
<tr>
<td>Types of Theses and Dissertations</td>
<td>18</td>
</tr>
<tr>
<td>General Standards and Guidelines for Traditional Theses and Dissertations</td>
<td>19</td>
</tr>
<tr>
<td>Order of Thesis/Dissertation Elements in Print Copy</td>
<td>19</td>
</tr>
<tr>
<td>Article-Based Theses and Dissertation Guidelines</td>
<td>20</td>
</tr>
<tr>
<td>Abstract</td>
<td>21</td>
</tr>
<tr>
<td>Introduction and Conclusion</td>
<td>21</td>
</tr>
<tr>
<td>Chapter/Article Variation from Published Version</td>
<td>21</td>
</tr>
<tr>
<td>References</td>
<td>21</td>
</tr>
<tr>
<td>Articles Not Yet Published</td>
<td>22</td>
</tr>
<tr>
<td>Thesis/Dissertation Elements</td>
<td>23</td>
</tr>
<tr>
<td>Title Page</td>
<td>23</td>
</tr>
<tr>
<td>Copyright Page</td>
<td>26</td>
</tr>
<tr>
<td>Electronic Defense Committee Approval and Final Reading Approval Page</td>
<td>29</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>29</td>
</tr>
<tr>
<td>Autobiographical Sketch of the Author</td>
<td>30</td>
</tr>
<tr>
<td>Abstract</td>
<td>30</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>31</td>
</tr>
<tr>
<td>List of Tables and List of Figures</td>
<td>31</td>
</tr>
</tbody>
</table>


CHAPTER THREE: THE GRADUATE COLLEGE THESIS/DISSERTATION TEMPLATE FOR MICROSOFT WORD

Overview ..................................................................................................................... 46

Writing Your Document within the Template ............................................................ 47

Downloading the Template ....................................................................................... 47

Replacing Content and Applying Styles .................................................................. 47

Formatting Landscape Pages ..................................................................................... 48

Replacing Table of Contents, List of Figures, and List of Tables ............................. 48

Attaching the Template to a Preexisting Document .................................................. 49

Formatting Styles ..................................................................................................... 49

Attaching the Template ......................................................................................... 50

Setting Page Numbers ............................................................................................. 51

Inserting Table of Contents, Lists of Tables, or List of Figures ............................... 52

Manually Formatting Your Document ........................................................................ 53

Creating a Single File from Multiple Files Using Microsoft Word ....................... 53

Setting Section Breaks in Microsoft Word ............................................................. 53

Formatting Page Numbers in Microsoft Word ......................................................... 54

Creating Dot Leaders for Manual Table of Contents in Microsoft Word .......... 55

Generating an Automatic Table of Contents Using Styles in Microsoft Word ....... 56

Creating Bookmarks for Your PDF Files in Microsoft Word ............................... 57

Creating a Single File from Multiple Files Using Acrobat Adobe Professional .... 58
CHAPTER FOUR: SCHOLARWORKS THESIS AND DISSERTATION REFERENCE MANUALLY

59

ScholarWorks-Based Review and Final Submission Process 59
Getting Started: Creating a ScholarWorks Account 59
Creating a ScholarWorks Account 60
ScholarWorks My Account: Overview 62
Edit Profile 63
Research Alerts 64
Author Dashboard 64
Follow Management 65
Author FAQ 65
Submit Research 65
Uploading Thesis/Dissertation to ScholarWorks for Review 65
Thesis/Dissertation Metadata Page: Detailed Instructions 69
Accessing Editor Feedback and Attached Documents 76
Accessing Thesis and Dissertation Office Feedback and Attachments 76
Uploading a Revision of the Thesis/Dissertation 78

BIBLIOGRAPHY 79

APPENDIX A 80
Example Pages 80

APPENDIX B 100
Common Mistakes Observed During Format Review and Editing Marks Used on Format Review 100
LIST OF TABLES

Table 1.1  August 2014 Graduation – Thesis and Dissertation Process
            Deadlines................................................................................................... 11
Table 1.2  December 2014 Graduation – Thesis and Dissertation Process
            Deadlines................................................................................................... 12
Table 1.3  May 2015 Graduation – Thesis and Dissertation Process Deadlines ...... 13
Table 1.4  August 2015 Graduation – Thesis and Dissertation Process Deadlines .. 13
Table 2.1  Formatting Title Page Elements......................................................... 23
Table 2.2  General Formatting Guidelines......................................................... 33
Table 3.1  Word Styles and the Sections to Which They Should Be Applied........ 49
### LIST OF FIGURES

<table>
<thead>
<tr>
<th>Figure 2.1</th>
<th>This Is an Example Figure</th>
<th>40</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 4.1</td>
<td>Clicking the My Account link</td>
<td>60</td>
</tr>
<tr>
<td>Figure 4.2</td>
<td>Clicking the Sign Up button in the Create New Account screen</td>
<td>61</td>
</tr>
<tr>
<td>Figure 4.3</td>
<td>Clicking Sign Up after completing required fields</td>
<td>61</td>
</tr>
<tr>
<td>Figure 4.4</td>
<td>New Account message</td>
<td>62</td>
</tr>
<tr>
<td>Figure 4.5</td>
<td>Activation E-mail message</td>
<td>62</td>
</tr>
<tr>
<td>Figure 4.6</td>
<td>The ScholarWorks Author Account main page</td>
<td>63</td>
</tr>
<tr>
<td>Figure 4.7</td>
<td>Clicking Submit Research on My Account page</td>
<td>66</td>
</tr>
<tr>
<td>Figure 4.8</td>
<td>Clicking Boise State University Theses and Dissertations on Submit Your Research page</td>
<td>66</td>
</tr>
<tr>
<td>Figure 4.8</td>
<td>The Submission Instructions and Access Agreement page (1 of 2)</td>
<td>67</td>
</tr>
<tr>
<td>Figure 4.9</td>
<td>The Submission Instructions and Access Agreement page (2 of 2)</td>
<td>68</td>
</tr>
<tr>
<td>Figure 4.10</td>
<td>My Account main page with Thesis/Dissertation submission</td>
<td>69</td>
</tr>
<tr>
<td>Figure 4.11</td>
<td>The Thesis/Dissertation Metadata page: Title, Author, Defense Date fields</td>
<td>71</td>
</tr>
<tr>
<td>Figure 4.12</td>
<td>The Thesis/Dissertation Metadata page: Degree Title, Department, and Advisor(s) fields</td>
<td>72</td>
</tr>
<tr>
<td>Figure 4.13</td>
<td>Format for professor name</td>
<td>73</td>
</tr>
<tr>
<td>Figure 4.14</td>
<td>Format for Advisor field if there are Co-Chairs</td>
<td>73</td>
</tr>
<tr>
<td>Figure 4.15</td>
<td>The Thesis/Dissertation Metadata page: Keywords and Subject Categories fields</td>
<td>74</td>
</tr>
</tbody>
</table>
CHAPTER ONE: THESIS AND DISSERTATION PROCESS

New Changes: ScholarWorks

Several significant changes have been made to the thesis and dissertation handbook; these changes center on one significant fact: the theses and dissertation is now paperless.

Thesis and Dissertation Process: Paperless!

Almost all of the thesis and dissertation final process is now paperless. This means DO NOT BUY FANCY PAPER. The standard 25% cotton, bright white, and watermarked paper that has been our standard in the past is no longer required.

The approval pages and Access Agreement for a Thesis or Dissertation will be printed, one copy only, on regular paper. Please ensure signatures are in blue or black ink.

For more regarding the new process for uploading your electronic review copy to ScholarWorks and submitting your final thesis or dissertation after review, please see “Chapter Four: ScholarWorks Thesis and Dissertation Reference Manual.”

Copies of Thesis/Dissertation for Binding

You will no longer need to print copies of your thesis or dissertation. The entire thesis and dissertation process, from format review to approval by the Dean of the
Graduate College, as well as final submission to the library and personal bound copies, will all be done electronically.

Please note that since you will no longer need to buy fancy paper, the binding cost might seem higher. This is because the cost of paper is now included in the binding fee. Please see “Chapter Four: ScholarWorks Thesis and Dissertation Reference Manual” for more information.

Please see the sections below for detailed information regarding these changes and other thesis/dissertation specific information. Also, please see the current Boise State University Graduate Catalog (http://graduatemall.boisestate.edu/) for additional information regarding official Graduate College policies and regulations, as well as college, department, and program details.

Summary of Entire Thesis/Dissertation Process

Overview

Note: Some of these items may be in a different order and may include other steps as determined by your department and advisor; this list is a general overview of the thesis/dissertation process. Elements required by the Graduate College must occur in the order dictated below.

1. Determine topic.
2. Write the research proposal (if required by department).
3. Select an advisor and committee. (Be sure to submit your Appointment to the Supervisory Committee form and Application to Admission to Candidacy form by this point. See the Graduate College website for these items.)
4. Research and write the thesis/dissertation. Note that an abstract is required.
5. Provide copies of the completed thesis/dissertation to your committee at least 2 weeks prior to defense. (Consult your department for exact expectations regarding the time needed for review by the committee and advisor prior to the defense date.)
6. Defend the thesis. If passing, have Defense Committee Approval form signed. Bring the form to the Graduate College.
7. Revise as per committee and advisor requests.
8. Submit a copy for your advisor to review; once approved, have the Final Reading Approval form signed.
9. At this time, complete and sign the Access Agreement for a Thesis or Dissertation, and have your advisor sign it.
11. Bring the Final Reading Approval form and Access Agreement for a Thesis or Dissertation to the Graduate College.
12. Once the Thesis and Dissertation Office has completed the review of your thesis/dissertation, you will receive a notification email. Please see your account in ScholarWorks and make the required changes provided by the Thesis and Dissertation Office. See “Chapter Four.”
13. Once you have made required changes, submit new revision into ScholarWorks. The Thesis and Dissertation Office will approve final copy or ask for additional changes.
14. Once the Dean of the Graduate College has approved your document and signed your Final Reading Approval page, you will receive an e-mail from the Graduate College with instructions on ordering bound copies of your thesis/dissertation.

Detailed

For any detailed information not provided below, please consult your advisor or contact the Graduate College. For additional information regarding required forms, see the “Thesis/Dissertation: Required Forms and Instructions” section. For additional information regarding thesis/dissertation elements and formatting guidelines, see Chapter Two.

Proposal

A thesis/dissertation proposal must be approved in advance by the supervisory committee. The thesis/dissertation proposal presents the background, objectives, scope, methods, and time lines of the thesis research. The proposal requirements are not
determined by the Graduate College but instead will be dictated by each specific department’s guidelines. Often, this proposal is part of an introductory research methods class; consult your advisor and/or department for details regarding the requirements of this proposal and whether a proposal is required as part of the thesis/dissertation process.

Note: Substantive work done by the student prior to the appointment of the supervisory committee or work represented by credit other than 593 Thesis (such as 596 Independent Study and 696 Directed Research) is not acceptable for the thesis under any conditions.

Committee Member Selection for the Thesis/Dissertation Committee

Make sure the committee members you want on your thesis/dissertation committee are eligible. The members on your thesis/dissertation committee must be on the graduate faculty approved by the Graduate Council. For a list of these professors, see the “Boise State University Graduate Faculty” and “Adjunct Graduate Faculty” sections of the current Boise State University Graduate Catalogue.

Abstract

An abstract is required. Because of the continued reliance on electronic media, the inclusion of an abstract is becoming increasingly important. As such, with the use of ScholarWorks and other such thesis/dissertation databases, an abstract becomes the only means of attracting readers to your research. See the “Abstract” section in Chapter Two for information about writing the abstract for your thesis/dissertation.

Review Copy for Defense Committee

Each department has specific expectations regarding the amount of time the committees require to properly review a thesis/dissertation before a defense. Consult with
the department and your advisor to determine the timeframe for submitting a review copy to your committee and defending for the graduation timeline you desire.

**Defense (Final Oral Examination) and Defense Committee Approval Page**

Schedule your defense as soon as reasonable to ensure you are able to provide your committee enough time to review your work and to ensure you will be able to meet all deadlines from your department and the Graduate College. The final deadlines for defending your thesis/dissertation and submitting the final copies of your thesis/dissertation to the Graduate College are often within a couple of weeks of each other; plan accordingly.

Consult your advisor regarding the normal procedures and expectations for a Final Oral Examination. Bring one copy of the thesis Defense Committee Approval page printed on white paper for the committee to sign once the final oral examination has been deemed satisfactory.

*Note:* The Defense Committee Approval page, Final Reading Approval page, and Access Agreement for a Thesis or Dissertation must be submitted to the Graduate College before your thesis will be reviewed by the Graduate College Thesis and Dissertation Office.

If the Final Oral Examination is unsuccessful for a thesis/dissertation defense, see the subsequent regulations and procedures in the *Boise State University 2014-2015 Graduate Catalog.*

**Advisor Final Reading Approval**

Following the Final Oral Examination, the defense committee may suggest changes and revisions they would like incorporated into the thesis/dissertation before the final electronic copy is submitted to the Graduate College for format review by the Thesis
and Dissertation Office. Once the changes are incorporated, provide a copy of the revised thesis to the major advisor (or thesis chair); include one copy of thesis Final Reading Approval page printed on white paper for the advisor to sign, if the thesis is found to be satisfactory to the advisor.

Once the Thesis Final Reading Approval page is signed, you may immediately deliver them to the Graduate College. The Defense Committee Approval page, Final Reading Approval page, and Access Agreement for a Thesis or Dissertation must be submitted to the Graduate College before your thesis will be reviewed by the Graduate College Thesis and Dissertation Office.

Thesis/Dissertation Format Review

A Format Review must be completed before you can turn the final electronic version of your thesis/dissertation to the Graduate College Thesis and Dissertation Office via ScholarWorks. Once you have defended your thesis successfully and have included all of the changes required by your committee, submit your final electronic version of your thesis/dissertation via ScholarWorks for format review; see “Chapter Four: ScholarWorks Thesis and Dissertation Reference Manual.”

Note: Please note that the Defense Committee Approval page, Final Reading Approval page, and Access Agreement for a Thesis or Dissertation must be submitted to the Graduate College before your thesis will be reviewed by the Graduate College Thesis and Dissertation Office.

When the Thesis and Dissertation Office has completed the review of your thesis/dissertation, you will receive notification electronically to the e-mail address you provided when submitting your document via ScholarWorks. Please see “Chapter Four: ScholarWorks Thesis and Dissertation Reference Manual” for additional information.
regarding accessing editor feedback and attachments, as well as how to submit a revision of your thesis/dissertation.

During a Format Review, the Thesis and Dissertation Office will ensure the accuracy of the Table of Contents, List of Figures, and List of Tables; in addition, the Thesis and Dissertation Office verifies and cross-references the internal and external reference citations. The Thesis and Dissertation Office will also verify the quality of the document submitted and will spend extra time verifying the detail and quality of the abstract.

Verify the quality of your document before submitting the document for review. The Thesis/Dissertation Coordinator is not a copy editor; rather, the Thesis/Dissertation Coordinator is a quality assurance specialist. If the thesis does not meet basic quality and thesis preparation guidelines, the document will be rejected. The document will then require further revision and modification by the student before it can be resubmitted for review by the Thesis and Dissertation Office. Any document rejected from review might be in danger of not meeting the deadline for the desired graduation date.

Please allow 4-6 weeks for review of your document by the Thesis and Dissertation Office. Please note that all documents submitted by the Review Copy Deadline will be processed and sent back to the student a minimum one week before the Final Document Deadline.

**Submission of Final Copies**

*Note: Only final copies that have been preceded by a format review will be accepted.*
Note: The thesis or dissertation requirement of a graduate degree program is not considered satisfied until the Dean of the Graduate College approves its final version.

After incorporating all changes required by the Thesis and Dissertation Office, submit the final version via ScholarWorks. Please see “Chapter Four: ScholarWorks Thesis and Dissertation Reference Manual.”

The final copies will undergo a further review by the Thesis and Dissertation in order to verify major changes required during the format review were incorporated. If the desired changes were not incorporated, your final copies may need to be resubmitted with the required changes. Failing to incorporate major changes might cause a delay in final processing, and potentially graduation.

Once the final copy of the thesis/dissertation is verified, the Thesis and Dissertation Office will submit the thesis to the Dean of the Graduate College for Final Review and Approval. The thesis or dissertation requirement of a graduate degree program is not considered satisfied until the Dean of the Graduate College approves the final version.

Once the Dean of the Graduate College approves the thesis/dissertation, he will sign the Final Reading Approval page and the Thesis and Dissertation Office will submit the final electronic copy for publication on ScholarWorks.

Personal Copies, Committee/Advisor Copies, and Department Copies

Once the final version of your thesis/dissertation has been approved by the Dean of the Graduate College, you will receive an e-mail from the Graduate College or Thesis and Dissertation Office congratulating you on your accomplishment. This e-mail will also
provide information for ordering bound copies of your thesis/dissertation. Please adhere to the deadline within the e-mail, as this is your only opportunity to buy bound copies of your document.

Please note that most departments require a departmental copy to be purchased. You are responsible for supplying this copy. The few departments that do not require a department copy are as follows: Raptor Biology, Educational Technology, Music, and Kinesiology.

Thesis/Dissertation: Required Forms and Instructions

Forms Filled Out Prior to Defense

Note: *The Appointment of Supervisor Committee form should be submitted prior to the Application for Admissions to Candidacy form.*

- **Appointment of Supervisory Committee form**—Fill out and submit this form to Graduate Admissions, located in the Riverfront Hall, office 307, the second semester of the first year. This form is available here: [http://graduatecollege.boisestate.edu/forms/](http://graduatecollege.boisestate.edu/forms/)

- **Application for Admissions to Candidacy form**—Fill out and submit this form to Graduate Admissions, located in the Riverfront Hall, office 307, the second semester of the first year. See the Academic Calendar for the exact deadline date. This form is available here: [http://graduatecollege.boisestate.edu/forms/](http://graduatecollege.boisestate.edu/forms/)

Forms Shortly After Defense and After Obtaining Final Reading Approval from Advisor

- **Thesis Defense Committee Approval page**—Print out one copy on white paper and have your committee members sign in blue or black ink after you have successfully defended your thesis. Bring the signed Defense Committee Approval page to the Thesis and Dissertation Office, located in the Riverfront Hall, office 307D. The template for this form is available here: [http://graduatecollege.boisestate.edu/forms/](http://graduatecollege.boisestate.edu/forms/)

- **Graduate College Access Agreement for Thesis or Dissertation form**—Complete and submit this form to the Thesis and Dissertation Office, located in Riverfront Hall, office 307D. This form provides you with the opportunity to dictate how you would like your electronic thesis accessed in ScholarWorks. It must be signed by both you and your advisor. If there are questions regarding this
form and the completion of this form, please contact the Thesis and Dissertation Office via e-mail (jodichilson@boisestate.edu) or phone (208-426-3604). This form is available here: http://graduatecollege.boisestate.edu/forms/

- **Thesis Final Reading Approval pages**—Print out one copy on white paper and have your thesis advisor sign it in blue or black ink after you’ve incorporated any changes the committee requested during defense. The thesis advisor’s signature ensures the final version of the thesis is satisfactory to the committee. The template for this form is available here: http://graduatecollege.boisestate.edu/forms/

**Dissertation Process**

**Overview**

The dissertation process is the same as the thesis process except for three major items, two of which pertain only to Ph.D. students: 1. All forms and necessary documents should specify Dissertation rather than Thesis (Ed.D. and Ph.D.); 2. Ph.D. students/advisors must request an External Examiner; and 3. Ph.D. students must complete a Survey of Earned Doctorates (SED) at the end of their dissertation process.

**External Examiner Is Assigned (Ph.D. Specific)**

An external examiner is appointed by the Dean of the Graduate College well in advance of the final oral examination by a process that begins when the chair of the supervisory committee submits a “Request for Appointment of an External Examiner for a Doctoral Dissertation” form to the Graduate College. The external examiner may be from the university or from outside the university but cannot be a member of the academic unit that is responsible for the Ph.D. program. The role of the external examiner is to provide a perspective from outside the academic unit on the quality of the dissertation and the student’s ability to present and defend it.
Survey of Earned Doctorates (SED) Form (Ph.D. Specific)

Complete this form electronically on the SED website:
https://sed.norc.org/doctorate. The SED is a survey from the National Organization for Research at the University of Chicago, which compiles data on Ph.D.s across the nation. They published a Summary Report detailing all of the doctorates awarded in the United States. The Graduate College at Boise State University will be automatically notified when you complete this survey.

**General Deadlines: Thesis and Dissertation**

The tables on the following pages contain only general deadlines; see the Academic Calendar and consult with your advisor for specific deadlines and how they relate to your thesis/dissertation process.

**Table 1.1 August 2014 Graduation – Thesis and Dissertation Process Deadlines**

<table>
<thead>
<tr>
<th>For August 2014 Graduation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>March 3</strong></td>
</tr>
<tr>
<td>Last day to submit “Application for Admission to Candidacy” form for August 2014 graduation: <a href="http://graduatecollege.boisestate.edu/forms/">http://graduatecollege.boisestate.edu/forms/</a></td>
</tr>
<tr>
<td>Note: Please make sure your Supervisory Committee form (<a href="http://graduatecollege.boisestate.edu/forms/">http://graduatecollege.boisestate.edu/forms/</a>) has been turned in well before this date; the Supervisory Committee form must be turned in before the Application for Admission to Candidacy form.</td>
</tr>
<tr>
<td><strong>June 12</strong></td>
</tr>
<tr>
<td>Last day to apply for graduation for August 2014 graduation (via my.BoiseState.edu).</td>
</tr>
<tr>
<td><strong>June 16</strong></td>
</tr>
<tr>
<td>Recommended last day to defend thesis/dissertation.</td>
</tr>
<tr>
<td><strong>July 7</strong></td>
</tr>
<tr>
<td>Last day to upload the final version of your thesis/dissertation for review (called the review copy) to the Graduate College Thesis &amp; Dissertation Office via ScholarWorks.</td>
</tr>
<tr>
<td>The thesis/dissertation copy submitted for review must be</td>
</tr>
</tbody>
</table>
defended and approved via the Final Reading Approval form signed by the thesis/dissertation chair.

*Note:* A review copy received after the deadline is not guaranteed to be completed in time for a August 2014 graduation.

**August 4**
Last day to upload final copy of thesis/dissertation to ScholarWorks for an August 2014 graduation.

---

**Table 1.2 December 2014 Graduation – Thesis and Dissertation Process Deadlines**

<table>
<thead>
<tr>
<th>Date</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>June 27</td>
<td>Last day to submit “Application for Admission to Candidacy” form for a December 2014: <a href="http://graduatecollege.boisestate.edu/forms/">http://graduatecollege.boisestate.edu/forms/</a></td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> Please make sure your Supervisory Committee form (<a href="http://graduatecollege.boisestate.edu/forms/">http://graduatecollege.boisestate.edu/forms/</a>) has been turned in well before this date; the Supervisory Committee form must be turned in before the Application for Admission to Candidacy form.</td>
</tr>
<tr>
<td>August 29</td>
<td>Last day to apply for graduation for December 2014 graduation (via my.BoiseState.edu).</td>
</tr>
<tr>
<td>October 17</td>
<td>Recommended last day to defend thesis/dissertation.</td>
</tr>
</tbody>
</table>
| November 7| Last day to upload the final version of your thesis/dissertation for review (called the review copy) to the Graduate College Thesis & Dissertation Office via ScholarWorks.  
  The thesis/dissertation copy submitted for review must be defended and approved via the Final Reading Approval form signed by the thesis/dissertation chair.  
  *Note:* A review copy received after the deadline is not guaranteed to be completed in time for a December 2014 graduation. |
| December 10| Last day to upload final copy of thesis/dissertation to ScholarWorks for a December 2014 graduation. |
Table 1.3  May 2015 Graduation – Thesis and Dissertation Process Deadlines

<table>
<thead>
<tr>
<th>For May 2015 Graduation</th>
</tr>
</thead>
</table>
| October 6               | Last day to submit “Application for Admission to Candidacy” form for May 2015 graduation: [http://graduatecollege.boisestate.edu/forms/](http://graduatecollege.boisestate.edu/forms/)  
  Note: Please make sure your Supervisory Committee form ([http://graduatecollege.boisestate.edu/forms/](http://graduatecollege.boisestate.edu/forms/)) has been turned in well before this date; the Supervisory Committee form must be turned in before the Application for Admission to Candidacy form. |
| January 16              | Last day to apply for graduation for May 2015 graduation (via my.BoiseState.edu). |
| March 6                 | Recommended last day to defend thesis/dissertation. |
| March 16                | Last day to upload the final version of your thesis/dissertation for review (called the review copy) to the Graduate College Thesis & Dissertation Office via ScholarWorks.  
  The thesis/dissertation copy submitted for review must be defended and approved via the Final Reading Approval form signed by the thesis/dissertation chair.  
  Note: A review copy received after the deadline is not guaranteed to be completed in time for a May 2015 graduation. |
| May 1                   | Last day to upload final copy of thesis/dissertation to ScholarWorks for a May 2015 graduation. |

Table 1.4  August 2015 Graduation – Thesis and Dissertation Process Deadlines

<table>
<thead>
<tr>
<th>For August 2015 Graduation</th>
</tr>
</thead>
</table>
| February 20               | Last day to submit “Application for Admission to Candidacy” form for August 2015 graduation: [http://graduatecollege.boisestate.edu/forms/](http://graduatecollege.boisestate.edu/forms/)  
  Note: Please make sure your Supervisory Committee form ([http://graduatecollege.boisestate.edu/forms/](http://graduatecollege.boisestate.edu/forms/)) has been turned in well before this date; the Supervisory Committee form must be turned in before the Application for Admission to Candidacy form. |
<p>| June 12                   | Last day to apply for graduation for August 2015 graduation (via my.BoiseState.edu). |</p>
<table>
<thead>
<tr>
<th>Date</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>June 16</td>
<td>Recommended last day to defend thesis/dissertation.</td>
</tr>
<tr>
<td>July 7</td>
<td>Last day to upload the final version of your thesis/dissertation for</td>
</tr>
<tr>
<td></td>
<td>review (called the review copy) to the Graduate College Thesis &amp;</td>
</tr>
<tr>
<td></td>
<td>Dissertation Office via ScholarWorks.</td>
</tr>
<tr>
<td></td>
<td>The thesis/dissertation copy submitted for review must be defend</td>
</tr>
<tr>
<td></td>
<td>ed and approved via the Final Reading Approval form signed by the</td>
</tr>
<tr>
<td></td>
<td>thesis/dissertation chair.</td>
</tr>
<tr>
<td></td>
<td>Note: A review copy received after the deadline is not guaranteed</td>
</tr>
<tr>
<td></td>
<td>to be completed in time for a August 2015 graduation.</td>
</tr>
<tr>
<td>August 4</td>
<td>Last day to upload final copy of thesis/dissertation to ScholarWorks</td>
</tr>
<tr>
<td></td>
<td>for an August 2015 graduation.</td>
</tr>
</tbody>
</table>

**On-Campus Services for Students**

There are several free services on campus to assist with research and writing for graduate students. These include two main service providers: The Writing Center and the Albertsons Library. Other services may be provided as per each academic unit or department; consult with your advisor and department regarding other services that might be available.

**The Writing Center**

The Writing Center is a service center provided by the English Department for all students at Boise State University. The Writing Center will assist any writer with any stage of the writing process through one-on-one or email consultations. Please see the Writing Center website for more information or to set up an appointment:

[http://writingcenter.boisestate.edu](http://writingcenter.boisestate.edu).
Albertsons Library

The Albertsons Library on campus provides research and research knowledge assistance to any Boise State University student. The Albertsons Library does this through three main means: 1) one-on-one consultation via walk-in service or online chat; 2) one-on-one consultation via your library liaison; and 3) through informal workshops.

One-on-One or Email Consultation via Walk-in Service or Online Chat

The Albertsons library is well staffed with friendly and knowledgeable librarians, who will be able to assist or direct you. There is also 24-hour assistance available via chat from the library, so you can ask questions and receive immediate research assistance anytime from any location. Please see the Albertsons Library homepage for these and other services. Click here to discover how: http://library.boisestate.edu/help/contact.php

Library Liaison

Each department is assigned a library liaison, which means for each department a librarian is assigned who specializes in the subject matter, reference requirements, and research knowledge for that particular field. These library liaisons are available to assist the student in their assigned subject and are an invaluable source for the graduate students. The library liaison is available to answer questions and provide consultation via e-mail, phone, and in-person consultation. To find the library liaison for your department, consult the Albertson’s Library website, and click “Contact Your Librarian”; or, see the following link: http://library.boisestate.edu/about/liaisons.php.
Library Workshops

A number of workshops will be offered throughout the semester. Please contact your library liaison for information regarding these workshops and other resources for research and citation assistance. These workshops in the past have focused on topics such as the following: Using EndNote, Copyrights, Citing Sources, etc.
CHAPTER TWO: THESIS/DISSERTATION ELEMENTS,
STANDARDS, AND GUIDELINES

Overview

The student is responsible for all of the content and formatting of the thesis/dissertation. A student may acquire assistance for formatting and copyediting of the document, but all changes directly to the content are the student’s responsibility. See the following guidelines for formatting the thesis/dissertation according to the Boise State University Graduate College standards. Many students may find it easiest to use our document template, which can be found on the Thesis & Dissertation website: http://graduatecollege.boisestate.edu/thesisdissertation/template/. Detailed instructions for using the template can be found in Chapter Three. Also, please note that this manual is formatted with the same styles and standards required in your thesis/dissertation and can be used as an example of proper formatting.

Note: Any thesis/dissertation failing to meet these standards and guidelines may be rejected during format review.

Please also consult with your thesis/dissertation chair and the styles guide specific to your department and discipline for additional guidelines. Unless approved by the Graduate College, you are expected to adhere to all required formatting guidelines in this handbook.
Institutional Review Board (IRB) Approval

Any thesis/dissertation that required IRB Approval before data collection MUST note the receipt of IRB Approval in the thesis/dissertation. This needs to be done in two ways: once through reference to the IRB Approval and process in the document text, and inclusion of the IRB Approval letter as an appendix item.

See the Office of Research Compliance website for more information regarding compliance: http://research.boisestate.edu/compliance/

Institutional Animal Care and Use Committee (IACUC) Approval

Any thesis/dissertation that required IACUC Approval before data collection MUST note the receipt of IACUC Approval in the thesis/dissertation. This needs to be done in two ways: once through reference to the IACUC Approval and process in the document text, and inclusion of the IACUC Approval letter as an appendix item.

See the Office of Research Compliance website for more information regarding compliance: http://research.boisestate.edu/compliance/

Types of Theses and Dissertations

There are two major types of thesis and dissertation styles: 1) traditional, and 2) an article-based thesis or dissertation. For the traditional method, follow the general styles and standards below. For the article-based thesis or dissertation, see the “Article-Based Thesis or Dissertation Guidelines” below.
General Standards and Guidelines for Traditional Theses and Dissertations

Order of Thesis/Dissertation Elements in Print Copy

The order of some of these elements may vary depending on your discipline/field. Unless otherwise approved by the Graduate College Thesis and Dissertation Office, the order of your thesis/dissertation must be as follows.

Details regarding the composition of these elements are provided in the “Thesis/Dissertation Elements” section below.

Note: Not all of the elements in this list are required. All required elements are in bold.

The order of thesis/dissertation elements is as follows:

- **Title Page**
- **Copyright Page**
- **Defense Committee Approval and Final Reading Approval page**
- **Dedication**
- **Acknowledgements**
- **Autobiographical Sketch of the Author**
- **Abstract**
- **Table of Contents**
- **List of Tables** (required if you have tables)
- **List of Figures** (required if you have figures)
- **List of Graphs** (required if you have graphs)
- **List of Plates or Photos** (required if you have plates or photos)
- **List of Maps** (required if you have maps)
- **List of Abbreviations**
- **List of Symbols**
- **Text**
Article-Based Theses and Dissertation Guidelines

Note: If you plan to submit an article-based thesis or dissertation, please contact the Thesis and Dissertation Office, as pre-approval may be required.

Also called the “multi-paper format,” a thesis or dissertation in this style is composed of a few to several articles or research papers. These articles or research papers can be previously published, in press, or unpublished, but the student MUST be the sole or major contributor. Articles and papers for which the student is not the sole or major contributor cannot be used in the body of the thesis or dissertation, but may be used in the appendices.

The student is responsible for acquiring all copyright permissions, including permission by the copyright holder (often the journal in which the article was published) and permission from the contributing authors, not including those on the supervisory committee. The permissions letters must be included in the appendices of the thesis or dissertation.

See the appendices also for examples of the permissions letters that will need to be sent and collected from the copyright holders and contributing authors.

The article-based thesis or dissertation MUST still adhere to the formatting styles and standards required by the Graduate College Thesis and Dissertation Office, such as margins, document styles, thesis elements, etc.
Abstract

Each article or paper will likely have an abstract already included. However, for a thesis or dissertation composed of chapter/articles, there must be an abstract in the front matter of the document. This abstract extends over the entire thesis or dissertation and should discuss succinctly the work of the entire thesis or dissertation.

Introduction and Conclusion

The article-based thesis or dissertation should begin with an Introduction that clearly summarizes the research and information the reader will find in the thesis or dissertation chapters/articles. In addition, the thesis or dissertation should conclude with a Conclusion chapter that summarizes the end results and further research discoveries.

Chapter/Article Variation from Published Version

When copyright is acquired from the copyright holder, it is understood that the content of the thesis or dissertation has been modified—whether through minor changes such as grammar and style or through greater modifications to data and figures.

References

As the article-based thesis or dissertation contains articles that are likely published or pending publication in different journals, each chapter should have its own references list, which should appear after the chapter. The in-text citations and references list are prepared according to the standards followed for each chapter.

In addition, if the Introduction and Conclusion chapter contain citations, ensure there is a references list for these two chapters as well. Ensure the same style of citation method used in the Introduction is used for the Conclusion chapter, and clearly indicate
which method or style is used for these chapters when submitting your review copy to the Graduate College Thesis and Dissertation Office.

**Articles Not Yet Published**

For articles in press, meaning that they have been accepted and are pending publication, ensure you acquire copyright permissions from the copyright holder and contributing authors in the same manner for published articles. In addition, ensure you follow the copyright regulations for that journal.

For articles that have been submitted to the journal or have not yet been submitted, ensure you are aware of the journal’s publication limitations with regard to thesis or dissertation submission and publication.

For example, when submitting to the American Chemical Society (ACS) and journals that use the ACS styles and standards, the student will likely need to select Option 3 on the Access Agreement for a Thesis or Dissertation, which is a required form that must be submitted to the Graduate College Thesis and Dissertation Office. This option embargoes the final thesis or dissertation for two years, which will allow ample opportunity for the article to be submitted and published by the ACS-based journal.

Others like the Environmental Science and Technology journal, for instance, require that the article, once published in the journal, not be made public in the theses or dissertations database for at least one year, after which time the journal provides open access.
Thesis/Dissertation Elements

Title Page

The title page is considered page i in the thesis/dissertation; however, no page number should be listed on this page.

See Appendix A for an example of a correctly formatted title page; ignore the page number in the upper-right corner of this example page as the numbering is for this handbook only. See Table 2.1 for details regarding the elements of the title page and the formatting required.

Table 2.1 Formatting Title Page Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title should be centered and listed in all caps two inches from the top of the page.</td>
</tr>
<tr>
<td></td>
<td>Titles should be clear and concise and should clearly indicate the focus of the thesis/dissertation. A reader should be able to determine the subject matter and the field simply by reading the title.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td><strong>Unclear Title:</strong> STUDENT JOURNALS</td>
</tr>
<tr>
<td></td>
<td><strong>Clear Title:</strong> USING STUDENT JOURNALS IN THE CLASSROOM TO ENHANCE STUDENT LEARNING</td>
</tr>
<tr>
<td></td>
<td>When a title takes more than one line on the title page, break the title logically into two or more lines. Do not end a title line with a preposition or conjunction.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td><strong>Incorrectly Broken Title:</strong></td>
</tr>
<tr>
<td></td>
<td>USING STUDENT JOURNALS IN THE</td>
</tr>
</tbody>
</table>
| **CLASSROOM TO**  
| **ENHANCE STUDENT LEARNING** |
| **Correctly Broken Title:** |
| **USING STUDENT JOURNALS**  
| **IN THE CLASSROOM TO ENHANCE STUDENT LEARNING** |
| or |
| **USING STUDENT JOURNALS IN THE CLASSROOM**  
| **TO ENHANCE STUDENT LEARNING** |

Avoid the use of phrases such as “A Study of,” “Laboratory Investigations of,” and other such introductory phrases in the title.

Abbreviations and symbols should not be used in titles unless they are of standard usage and recognized in the discipline.

| **Author’s Name** |
| The author’s full name should be placed in the center of the page and must be the same name as is listed officially in the student’s record. |
| The author’s name must be identical to the primary name listed in my.BoiseState.edu. If you wish to use a different official name, you must change the name in my.BoiseState.edu and in the official record in order to have this different name listed on the title page. |

| **Degree Title and Degree Fulfillment Paragraph** |
| Thesis: The degree title and degree fulfillment paragraph must be centered on the bottom third of the page. Ensure the correct document type is listed: thesis or dissertation. Also, ensure the correct degree title is listed; double-check this degree title against the Graduate catalogue. This degree title must be listed exactly (including punctuation or no punctuation) as it is listed in the Graduate Catalogue. |
| The text of this paragraph is as follows, and must be listed as such, including the same capitalization and punctuation: |
| A thesis |
submitted in partial fulfillment of the requirements for the degree of Master of [Arts or Science] in [Discipline] Boise State University

For example:

A thesis submitted in partial fulfillment of the requirements for the degree of Master of Fine Arts in Creative Writing Boise State University

Another example:

A thesis submitted in partial fulfillment of the requirements for the degree of Master of Science in Kinesiology Boise State University

**Dissertation:** The degree title and degree fulfillment paragraph must be centered on the bottom third of the page. Ensure the correct document type is listed: thesis or dissertation. Also, ensure the correct degree title is listed; double-check this degree title against the Graduate catalogue. This degree title must be listed exactly (including punctuation or no punctuation) as it is listed in the Graduate Catalogue.

The text of this paragraph is as follows and must be listed as such, including the same capitalization and punctuation:

A dissertation submitted in partial fulfillment of the requirements for the degree of Doctor of [Education or Philosophy] in [Discipline] Boise State University
For example:

A dissertation
submitted in partial fulfillment
of the requirements for the degree of
Doctor of Education in Curriculum and Instruction
Boise State University

Another example:

A dissertation
submitted in partial fulfillment
of the requirements for the degree of
Doctor of Philosophy in Electrical and Computer Engineering
Boise State University

<table>
<thead>
<tr>
<th>Month and Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>This text should be centered and listed exactly one inch from the bottom of the page and two double spaces beneath the degree title and degree fulfillment paragraph.</td>
</tr>
<tr>
<td>The month listed should be one of three months, depending on the month you are graduating: December, May, or August. There should be no comma between the month and the year listed.</td>
</tr>
<tr>
<td><strong>Incorrect:</strong> Spring 2014</td>
</tr>
<tr>
<td><strong>Incorrect:</strong> Spring, 2014</td>
</tr>
<tr>
<td><strong>Correct:</strong> May 2014</td>
</tr>
</tbody>
</table>

**Copyright Page**

Type the author’s name exactly as it appears on the title page. This page is considered page ii; however, this page should not be paginated.
See Appendix A for an example of the copyright page; ignore the page number in the upper-right corner of this example page as the numbering is for this handbook only.

**Copyrights**

As the author of a thesis/dissertation, you hold common law copyright before publication, and no one can legally copy it without your consent. When the electronic thesis/dissertation is posted in ScholarWorks, it is considered a published document. By entering a copyright notice in the thesis/dissertation on the page following the title page, you will have statutory copyright. If you wish to copyright your thesis/dissertation in this way, each copy of the thesis/dissertation must include this page.

To enforce copyright, in the case of infringement, a copyright must be registered with the United States Copyright Office. Register the copyright as soon as possible after publication (i.e., posting of the document in the library database via ScholarWorks). To register your copyright, write to the U.S. Copyright Office at the following address and ask for a copy of Form TX, “Application for Registration of a Claim to Copyright”:

U.S. Copyright Office
The Library of Congress
Washington, D.C. 20559

Complete the form and return it with one soft-bound copy of your thesis/dissertation and the appropriate fee to the U.S. Copyright Office. You are responsible for the registration of copyright; the University cannot do it for you.

See the Library of Congress website for additional information regarding copyrights: [http://lcweb.loc.gov/copyright/](http://lcweb.loc.gov/copyright/).
Creative Commons Licensing

In addition to your copyright, you may choose to apply a Creative Commons (CC) license to your thesis/dissertation. CC licenses protect your rights to ownership yet allow for greater freedom in sharing information. You as the author can customize the way you allow readers to use your work by choosing from a set of free licenses that dictate terms of usage. The licenses contain different combinations of the following four attributes:

- **Attribution**: Requires users to credit you as the creator of your original work. All CC licenses require attribution.
- **No Derivatives**: Prohibits users from altering your work.
- **Non-Commercial**: Allows users to use your work solely for non-commercial purposes.
- **Share Alike**: Requires any users who use your work to license their new creations under identical terms.

CC Licenses provide an easier way for users to access and use your work, resulting in a wider distribution of your information and talents. You still have control over the way your work is used, but CC licenses streamline the permission process.

All CC licenses are non-exclusive, meaning that you will still be able to enter into separate, non-exclusive contracts if you so desire (such as for commercial gain). However, you will not be able to enter into exclusive contracts, even if you stop distributing your work under the CC license. All copies of your work already in circulation would still be available to the public under the terms of the original license.

To obtain a CC license, visit [http://creativecommons.org/choose](http://creativecommons.org/choose). Here you will be asked to answer a few questions that determine the type of license best suited for you. Once you have filled out and submitted your answers, a license code will be generated for you that can be copied and inserted into your document. This code will replace the
traditional copyright information. See Appendix A for an example of how to include a
CC license in your work.

For more information on Creative Commons licensing, visit
http://creativecommons.org.

Electronic Defense Committee Approval and Final Reading Approval Page

On the electronic Defense Committee Approval and Final Reading Approval page in the thesis/dissertation, please ensure thesis or dissertation is used throughout as needed. Also ensure the content is updated for your specific situation. That is, ensure the title is that of your document, your name is listed (as it is on the signed approval pages and on the title page and copyright page) on the top of the page and in the paragraph text, ensure the correct defense date is listed, and your advisor and committee members are listed correctly with their correct degree title (Ph.D., Ed.D, M.F.A., etc.).

Acknowledgements

Please ensure that all individuals listed with a doctoral degree are acknowledged as such with the appropriate title listed before their name. If the acknowledged person has multiple titles, use the highest title marker, as appropriate.

Please see the following for the most common Acknowledgements errors.

Incorrect: Doctors Elizabeth Barber and Fred MacIntyr

Special thanks to my committee members: Elizabeth Barber and Fred MacIntyr.

Correct: Dr. Elizabeth Barber and Dr. Fred MacIntyr
In addition, if selections of this thesis/dissertation appear in publication elsewhere, please indicate this in the Acknowledgements.

**Autobiographical Sketch of the Author**

The Autobiographical Sketch of the Author is not a biographical element to list the life history of the author. Rather, this element should be utilized to highlight the academic and professional career of the author. As appropriate, list previous publications and conference papers in this section.

**Abstract**

An abstract is required. The abstract should include the following: a definitive-statement of the problem; a brief description of the research method(s) and design; major findings, including significance or lack thereof; and conclusions. The abstract is limited to approximately 500 words.

Because of the increasing reliance on electronic media, the abstract is crucial. The abstract is typically the first thing, other than the title, a reader sees, and it largely determines whether or not the document will be read. If an abstract does not clearly outline the thesis of the work, the methods and considerations of the research, and the research and findings contained in the document, the thesis/dissertation will likely not be read.

See the styles guide recommended by your department, field, and advisor for more information regarding the abstract. Also, please see the *ANSI/NISO Z39.14 - Guidelines for Abstracts* listing in the “Bibliography” of this handbook; this reference has detailed explanations and examples of abstracts.
Table of Contents

The Table of Contents should only list Heading 1, Heading 2, and Heading 3 listings. All other headings and subheadings are omitted from the Table of Contents page. Do not list the title page, copyright page, approval pages, and the Table of Contents on the Table of Contents page.

See Appendix A for an example of a Table of Contents.

If the template is used, right-click the Table of Contents and click Update Field. If the correct styles are used throughout the document, the Table of Contents will correctly populate.

List of Tables and List of Figures

If the document contains tables and/or figures, these items must be listed in a List of Tables and/or List of Figures, respectively. See Appendix A for an example of a List of Tables and a List of Figures.

References, Bibliography, or Works Cited

For the References, Bibliography, or Works Cited, use the citation method suggested by your discipline and the corresponding styles guidelines. See the styles guide for your discipline to determine which type of References list you need and what you must include in your list.

It is the student’s responsibility to verify that the spelling of each reference and the year of publication cited in the text, figures, and tables agree with the corresponding entries in the references list.

Unless your department requires a specific style that has been approved by the Graduate College, all reference lists should be typed single-spaced with double spacing.
between entries. The first line of each reference is flush with the left margin and the succeeding lines are indented; i.e. use hanging indent for the entries.

See the “Citation and Reference Standards and Guidelines” section below for details regarding this section. Also, see Appendix A for an example of a Works Cited page in MLA.

Appendix

The appendix should have a title page preceding the appendix content. This title page will contain the words “APPENDIX” and the corresponding letter according to the number of appendices. Below this Heading 1 title, a corresponding subheading (Heading 2) should indicate what is included in the appendix; this subheading should be a single clear title.

In the Table of Contents, this appendix will be listed according to the title page pagination. If there is a single appendix, then a corresponding alpha-numeric number is not needed. For example, if there is only one appendix, the title (Heading 1) will simply be “APPENDIX.” If there are multiple appendices, the titles (Heading 1s) will be as follows, depending on the number of appendices: APPENDIX A, APPENDIX B, APPENDIX C, etc.

See the appendices in this handbook for examples; also see the Table of Contents in this handbook for examples of how to format the appendices in the Table of Contents.
Formatting Styles and Guidelines

General Formatting Guidelines

The table below outlines general formatting guidelines. Note that this manual is formatted with the same styles and standards required in your thesis/dissertation and can be used as an example of proper formatting. Also, please see Appendix A for example pages.

Note: Any templates for approval pages on the Graduate College website should not be modified to fit the General Formatting Guidelines outlined below. Change only the names and the gendered pronouns. Do not change margins or add page numbers.

Table 2.2 General Formatting Guidelines

<table>
<thead>
<tr>
<th>General Formatting Guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Margins</strong></td>
</tr>
<tr>
<td><strong>Left Margin</strong> = 1.5 inches</td>
</tr>
<tr>
<td><strong>Top Margin</strong> = 1 inch, unless it precedes a Heading 1, in which case, the top margin is 2 inches</td>
</tr>
<tr>
<td><strong>Right Margin</strong> = 1 inch</td>
</tr>
<tr>
<td><strong>Landscape-Oriented Pages</strong> = Top Margin: 1.5 inches, all other margins: 1 inch</td>
</tr>
<tr>
<td><strong>Page Numbers</strong></td>
</tr>
<tr>
<td>Page numbers should be the same font and font size as the text.</td>
</tr>
<tr>
<td><strong>Front Matter:</strong> Page numbers for the front matter should consist of Roman Numerals in the bottom center of the page, 1 inch from the bottom of the page. Page counting</td>
</tr>
<tr>
<td><strong>Headings</strong></td>
</tr>
<tr>
<td>--------------</td>
</tr>
<tr>
<td><strong>Heading 1:</strong> Heading 1s, which includes front matter listings, Chapter titles, and back matter listings should begin a new page and should be listed in all caps in the center of the page, 2 inches from the top of the page. These headings include, but are not limited to, the following examples: DEDICATION, ABSTRACT, TABLE OF CONTENTS, CHAPTER 1, REFERENCES, APPENDIX.</td>
</tr>
<tr>
<td><strong>Heading 2:</strong> Follow Heading 1s, and should be in bold and title-capped and listed in the center of the page.</td>
</tr>
<tr>
<td><strong>Heading 3:</strong> Should be underlined and title-capped and are aligned left on the page.</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>General Formatting Guidelines</td>
</tr>
<tr>
<td>-----------------------------</td>
</tr>
<tr>
<td><strong>Heading 4:</strong> Should be underlined and title-capped and should be indented once.</td>
</tr>
<tr>
<td><strong>Heading 5:</strong> Should be underlined and title capped and should be indented twice. This heading should end in a period, and the paragraph text should start on the same line.</td>
</tr>
<tr>
<td>For example:</td>
</tr>
<tr>
<td>This Is a Heading 5 Example. This is where the content following this heading would start, and the paragraph and sentences would continue beneath this heading.</td>
</tr>
<tr>
<td><strong>Paragraph</strong></td>
</tr>
<tr>
<td>The first line of a paragraph in the thesis/dissertation should be indented. The paragraph text should be double-spaced, except in tables and lists, in which case 1.5 or single spacing is acceptable to ensure readability and clarity.</td>
</tr>
<tr>
<td><strong>Font &amp; Font Size</strong></td>
</tr>
<tr>
<td>Font: The font should be a serif font. Times New Roman is the standard and preferred font; however, Times and Garamond are also acceptable.</td>
</tr>
<tr>
<td>Font Size: 12-point font is required.</td>
</tr>
<tr>
<td><strong>MISC</strong></td>
</tr>
<tr>
<td>Print Sides: The document should be printed single-sided.</td>
</tr>
<tr>
<td>Spacing: The document content should be double-spaced. Single-space extended quotes (block quotes), footnotes, and bibliography, but double-space between paragraphs or items.</td>
</tr>
</tbody>
</table>
General Formatting Guidelines

| | Also, single-spacing or 1.5 spacing may be used in tables or lists to assist in readability and clarity of content. |
| | **Text Alignment**: All text should be aligned left, or justified depending on your field. |

Block Quotes

Occasionally, a quote from a referenced work will need to be used in a thesis/dissertation that is more than two (2) lines in length. In these instances, a block quote should be used to clearly designate to the reader what the quoted material is and where the voice of the author enters. These block quotes not only clarify references but also provide a clean and clear look in the document, which a long quote set in the paragraph text would hinder.

All block quotes should be indented and single spaced. An example of such formatting for a block quote is as follows:

This is an example of a block quote. This is a continued sentence of the block quote, and this is a continuation of that sentence. This is an example of a block quote. This is a continued sentence of the block quote, and this is a continuation of that sentence. This is an example of a block quote. (Saunders 28)

The text following the block is not indented, but is aligned left as it is a continuation of the paragraph. The block quote should not have quote marks, as convention indicates that the indented block is already designated as a quote.

Consult your discipline’s styles guide and your thesis/dissertation advisor to verify how a source is cited in a block quote.
**Bullet Lists**

The bullet should consist of a solid circle, and the bullet list should be indented one space, equivalent to the indentation of the first line of the paragraph that precedes it. For example:

- This is a properly formatted bullet item.
- This is a properly formatted bullet item.
- This is a properly formatted bullet item.
- This is a properly formatted bullet item.

**Cross-References**

Occasionally, there is need for an internal reference to a figure, a table, or another section of the document. In these instances, use the following standards and guidelines. The most important thing in these internal references is consistency.

When referring the reader to another section, figure, or table, ensure the location of this referred-to item is clear. This will determine how much information is required in your reference. For example, when referring a reader to something within this chapter of the handbook, a reference could say simply: “See Table 2.1.” or “See ‘Cross-References’ above.”

If however, the referred to item is in another chapter or major section of the document, provide more information for the reader to easily find the section. For example,

See the example Table of Contents in “Appendix A.”

Or,

If the location of the item is inherent in the reference, then a detailed cross-reference is unnecessary. For example, if a cross-reference is Chapter Two is asking the reader to refer to a figure in Chapter One, if the figures are numbered according to the chapter and number of the figure in that chapter, then only the reference to the figure is required:

See Figure 1.2.

Rather than,

See Figure 1.2 in Chapter One.

Margins

See “Table 2.1 General Formatting Guidelines” above.

Notes

If your document contains notes, the note items should be indented one space and the note should be set up with a hanging indent. The note should be in italics to differentiate the text from the document body. The following is an example:

Note:  This is an example of a note. A longer note will be indented with a hanging indent to clearly indicate the note text.

Number Lists

The number should start at 1 and should consist of no other ornamentation; the number list should be indented one space, equivalent to the indentation of the first line of the paragraph that precedes it. For example:

1. This is a properly formatted number list item.

2. This is a properly formatted number list item.
3. This is a properly formatted number list item.

4. This is a properly formatted number list item.

Page Numbers

See “Table 2.1 General Formatting Guidelines” above.

Paragraph

See “Table 2.1 General Formatting Guidelines” above for basic formatting guidelines for paragraphs.

In addition, paragraph text that follows a list or block quote should not be indented as it is a continuation of the paragraph preceding the list or block quote. See the “Block Quote” section above for an example.

Figures

Figures should be centered on the page. Every figure in the document should have a figure caption. As such, all figures in a document will be listed in a List of Figures, which will follow the Table of Contents (and follow the List of Tables, if the document has tables). The following is an example of a properly formatted figure, with the corresponding figure caption.
Figure Captions

The figure caption should be centered and bolded, placed beneath the figure to which it refers. The figure caption should be title capped. All figure captions must match the figure captions listed in the List of Figures.

The numbering for the figure captions can vary. The numbering can be chronological or based on the chapter in which the figure is located, and the subsequent number of the figure in that chapter. For example, the second figure in the third chapter of a thesis/dissertation could be numbered as “Figure 3.2 Here Is the Example Figure Caption.”

The figure caption should occur on the same page as the figure.

Figure Captions in Appendices

Regardless of which number style is adopted for the figure captions in the rest of the document, figure captions in the appendices must be listed with the appropriate appendix indicator and the subsequent number of the figure. For example, the third figure
listed in Appendix B would be numbered as “Figure B.3 Here Is the Example Figure Caption.”

This numbering system clearly indicates the location of the figure in the document for the reader when the reader is viewing the List of Figures, or when a reference is made in the document to the respective figure.

Footnotes

Refer to the styles guide for your discipline for instructions on how to format the footnotes section of your document. If no prescribed method is indicated, please use the following guidelines.

The footnotes should appear on the same page as the citations to which the footnotes refer. A line should separate the document text on the page and the footnote text. A space should precede and follow the line separating the text and footnotes. The footnotes should be single-spaced, and double-spaced between each footnote.¹ For an example, see the bottom of this page.²

Tables

Tables should be aligned left. The table must consist of a clear and concise table header, which indicates what the reader should expect in the table and how the reader is to read the table. The content in the table cells can be single spaced, rather than double spaced, for readability and clarity.

1 This is an example of footnote text. This sentence will carry over to the next in a single-spaced fashion, and the example footnote will continue.

2 This is an example footnote.
Every table should have a table caption listed above it. See “Table Captions” below for instructions on what to include in your table captions.

If the table must flow over multiple pages, ensure the table header repeats at the top of each page to indicate clearly to the reader how each column should be read.

**Table Captions**

The table caption should be aligned left and bolded, placed above the table to which it refers. The table caption should be title-capped. All table captions must match the table captions listed in the List of Tables.

The numbering for the table captions can vary. The numbering can be chronological or based on the chapter in which the table is located and the subsequent number of the table in that chapter. For example, the second table in the third chapter of a thesis/dissertation could be numbered as “Table 3.2 Here Is the Example Table Caption.”

The table caption should appear on the same page as the table.

**Table Captions in Appendices**

Regardless of which number style is adopted for the table captions in the rest of the document, table captions in the appendices must be listed with the appropriate appendix indicator and the subsequent number of the table. For example, the third table listed in Appendix B would be numbers as “Table B.3 Here Is the Example Table Caption.”
This numbering system clearly indicates the location of the table in the document for the reader when the reader is viewing the List of Tables, or when a reference is made in the document to the respective table.

**Citation and Reference Standards and Guidelines**

The citation and reference standards and guidelines for your thesis/dissertation are heavily determined by your discipline and field. Please ensure the accuracy of your internal and external citations, and ensure you have properly created your References, Bibliography, or Works Cited listing. Listed below are some general guidelines for preparing your citations; consult your advisor and the styles guides per your discipline for detailed reference-preparation guidelines.

You are responsible for adhering to the most current citation and reference styles and guidelines required by your field.

*Note:* *Any thesis/dissertation failing to meet basic standards and guidelines for citations, or failing to be accurate and diligent in referenced sources, may be rejected during Format Review.*

**Bibliography vs. References vs. Works Cited**

The type of references list you use depends on two main factors: 1) your discipline, and 2) how you intend to list sources. For example, if you use regular internal citation in which a shortened citation is used to refer the reader to the full citation listed in the references list, then you would want to use a References list or a Works Cited; which is to say, you would want to use a listing that consists of all of the sources you referred to in the document body. However, if you are using footnotes throughout the document as the main means of providing full citation information, you might prefer to
use a selected Bibliography; this selected Bibliography could list additional sources you found helpful but didn’t cite directly in the document and could also contain detailed listings from the internal citation.

In general, the References and Works Cited are the preferred method as these two citation listings provide the reader with clear source references to which they can refer for further information or confirmation of the research completed for the thesis/dissertation.

Sometimes the Bibliography is not limited in the items cited; in these instances, the Bibliography functions the same way as a References list or a Works Cited. See the *Chicago Manual of Style* for a detailed description of the differences in Bibliography choices and detailed descriptions of the References and Works Cited.

**Internal Citation**

Some method of internal citation is required. Whichever method is used, the reader should clearly and easily be able to determine the referenced source and, in addition, should be able to easily identify the full citation in the References, Works Cited, or Bibliography (or the full citation listed in the footnotes, depending on the citation method).

Please follow the convention used by your discipline; see the styles guide recommended by your department and/or thesis/dissertation advisor.

If you document contains footnotes, please see the “Footnotes” section above for information about formatting the footnotes section in your document.
Multimedia Files

Occasionally, a student may desire to have supporting media files with their thesis/dissertation. These may include video or music files, or other supporting media. These media files are not in place of the thesis/dissertation nor are they directly a part of the work; they are in support of the work, which means they add value, but the thesis/dissertation can stand alone without the additional files, video, etc.

In these cases, a student may wish to include the supporting media with their final thesis/dissertation. The supporting media can be uploaded at the same time as the thesis/dissertation into ScholarWorks.
CHAPTER THREE: THE GRADUATE COLLEGE THESIS/DISSERTATION

TEMPLATE FOR MICROSOFT WORD

Overview

Note: In order for your thesis, project, or dissertation to be uploaded correctly in the ScholarWorks system, the document must be in a single file. This single file can be a .DOC file, a .DOCX file, or a .PDF file.

For LaTex specific information, please see the instructions provided by your department. Minor aspects of this guide may differ slightly from the LaTex templates provided by your department.

The Graduate College offers a thesis/dissertation template that contains all required content and formatting. You can either write your document from within the template or apply the template’s formatting to your previously created work.

The following instructions are divided by the ways in which you will approach the formatting of your document: using the template from the beginning, applying the template to a previously created document, or manually formatting without the use of the template. Note that even when using the template from the beginning, there may be certain formatting elements (such as the pagination of landscape pages) that need to be done manually.
Writing Your Document within the Template

The following instructions should be referenced if you decide to write your document within the template. This option requires the least amount of work from students. For instructions on creating bookmarks within a pdf, see the Manually Formatting Your Document section below.

Downloading the Template

Download the Boise State Thesis and Dissertation Template from the Forms section of the Graduate College website. After it downloads, right-click on the file and select New, which will open a new document based on the template. This document can be saved under any name and in any location you wish.

Replacing Content and Applying Styles

Replace the names, dates, and gendered pronouns on the Title page, Copyright page, and Electronic Approval page with your information. Replace the template content with your own work.

IMPORTANT: When entering your own work into the template, be sure to apply the following styles to the appropriate parts of your document. Failure to do so will mean that your Table of Contents, List of Figures, and List of Tables will be incorrect.

- Heading 1
- Heading 2
- Heading 3
- Figure Caption
- Table Caption
- Appendix Heading 2
- Appendix Heading 3
These styles can be found by clicking the arrow in the lower right hand corner of the Styles section in the Home tab. To apply a style, simply highlight the text that you wish to format and click the appropriate name from the styles list.

**Formatting Landscape Pages**

When setting pages of your document to landscape orientation to accommodate large figures or tables, you must reformat their page numbers so that they will still be visible after binding.

1. Insert a section break before and after the figure or table.
2. Open the landscape page’s header by double-clicking within the header.
3. Deselect Link to Previous, located in the Navigation section of the Design tab. Repeat this step for the page following the landscape page.
4. Delete the landscape page’s current page number.
5. Click Insert ➔ Page Number (in the Header & Footer section) ➔ Page Margins.

*Note: If your other pages’ pagination disappears after inserting landscape page numbers, you likely did not turn off Link to Previous. Undo your changes to the page numbers and restart the instructions.*

**Replacing Table of Contents, List of Figures, and List of Tables**

After your writing and editing is complete, you will need to replace the Table of Contents, List of Figures, and List of Tables.

1. Right-click the existing TOC, LOF, or LOT.
2. Click Update Field.
3. Select Update entire table and click Ok.

*Note: All other lists (such as a List of Abbreviations or List of Graphs) are not automatically-updateable. Instead, the template includes examples of manually-created lists that can be altered to fit your needs.*
Attaching the Template to a Preexisting Document

If your document is at or near completion, it may be easier for you to attach the template to your existing file than to paste your document into the new template.

Formatting Styles

Before attaching the Thesis/Dissertation template to your document, you must first apply the following styles to the appropriate sections of your work. It does not matter how these styles look, only that the names of the styles match those in the following list exactly.

Table 3.1 Word Styles and the Sections to Which They Should Be Applied

<table>
<thead>
<tr>
<th>Style Name</th>
<th>Text to which you should apply the style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix Heading 2*</td>
<td>All Heading 2s in the appendices EXCEPT the subtitle listed on each appendix’s title page</td>
</tr>
<tr>
<td>Appendix Heading 3*</td>
<td>All Heading 3s in the appendices</td>
</tr>
<tr>
<td>Approval Page*</td>
<td>All content on the approval page (you may need to adjust alignment and text size after applying this style)</td>
</tr>
<tr>
<td>Copyright Page*</td>
<td>All content on the copyright page</td>
</tr>
<tr>
<td>Figure Caption*</td>
<td>All figure captions</td>
</tr>
<tr>
<td>Heading 1</td>
<td>• Chapter and Appendix titles&lt;br&gt; • Titles for all front matter pages except &lt;br&gt; • Title page&lt;br&gt; • Copyright page&lt;br&gt; • Approval pages&lt;br&gt; • Table of Contents</td>
</tr>
<tr>
<td>Heading 2</td>
<td>All Heading 2s, including Appendixes’ subtitles</td>
</tr>
<tr>
<td>Heading 3</td>
<td>All Heading 3s</td>
</tr>
<tr>
<td>Table Caption*</td>
<td>All table captions</td>
</tr>
<tr>
<td>Table of Contents*</td>
<td>The Table of Contents page’s title ONLY</td>
</tr>
<tr>
<td>Title of Document*</td>
<td>ONLY the title of your thesis/dissertation</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Title Page*</td>
<td>All content on the title page other than the work’s title</td>
</tr>
</tbody>
</table>

*These styles will not exist in your original document and thus will have to be created. See instructions below.

Attaching Styles

1. Highlight the text you wish to format
2. Click the appropriate style from the row of them in the Styles section of the Home tab.

*Note: If the style you are looking for is not included in the row of styles, click the arrow in the lower right-hand corner of the styles section for a full list of styles.*

Creating Styles

Some required styles will not be listed in the premade styles, thus you will need to create them yourself.

15. Highlight the text that you wish to format
16. Right click the text and select Styles ➔ Save selection as a New Quick Style.
17. Enter the appropriate style name and click Ok.

*Note: Remember, it does not matter how these styles look, only that the style names match the names listed above.*

Attaching the Template

After applying styles to your document, you can attach the template, which will fix most of your document’s formatting issues.

1. Download the template from the Forms section of the Graduate College’s website, making sure to note the location in which you save it.
2. Open the Word document containing your thesis/dissertation, click the Developer tab, and select Document Template.
3. In the Document Template section, click Attach.
4. Navigate to the folder in which you saved the template and select it.
5. Click Ok.
6. IMPORTANT: Check the box labeled “Automatically update document styles.”
7. Click Ok.

Note: If the Developer tab is not visible, follow the following instructions:

- Word 2007: Click the Office Button → Word Options → Popular → Show Developer tab in the Ribbon → Ok)
- Word 2010:
  1. Click the File tab → Options → Customize Ribbon →
  2. Select Developer from the list of options and click Add.
  3. Click OK to close the Options dialog box.

Setting Page Numbers

Be careful that you set section breaks between front matter and body text and also between portrait and landscape-oriented pages (see Manually Formatting Your Document for instructions on setting page breaks). Each has a different way of formatting their pagination.

Front Matter

1. Set a continuous section break immediately before the Heading 1 on the first page that follows your approval pages.
2. Set a continuous section break immediately before the title of Chapter 1.
3. Open the footer on the first page following your signed approval pages by clicking the Footer button in the Header & Footer section of the Insert tab and selecting Edit Footer.
4. Deselect Link to Previous, located in the Navigation section of the Design tab. This step is only necessary for the first numbered page in the front matter.
5. Insert page numbers. Front matter page numbers should be in lowercase Roman numerals and should be centered at the bottom of each page.

Body Text

1. Double-click inside the footer of the first page in Chapter 1.
2. Deselect Link to Previous, located in the Navigation section of the Design tab. This step is only necessary for the first page in the body text.
3. Delete the page numbers from the footer.
4. Open the header on the same page by double-clicking inside the header.
5. Deselect Link to Previous, located in the Navigation section of the Design tab.
6. Insert alpha-numeric page numbers, starting with 1, into the upper right hand corner of the pages.

**Landscape Pages**

When setting pages of your document to landscape orientation to accommodate large figures or tables, you must reformat their page numbers so that they will still be visible after binding.

1. Open the landscape page’s header by double-clicking within the header.
2. Deselect Link to Previous, located in the Navigation section of the Design tab.
3. Repeat step 3 on the page following the landscape page.
4. Delete the landscape page’s current page number.
5. Click Insert ➔ Page Number (in the Header & Footer section) ➔ Page Margins.

*Note: If your other pages’ pagination disappears after inserting landscape page numbers, you likely did not turn off Link to Previous. Undo your changes to the page numbers and restart the instructions.*

**Inserting Table of Contents, Lists of Tables, or List of Figures**

Finally, after your document’s content is complete, you will need to create the Table of Contents, List of Figures, and List of Tables.

1. Place the cursor on the first line of text after the Heading 1 of the section you are about to create.
2. Click on the Macros button
   - Word 2007: Located in the Code section of the Developer tab (if the Developer tab is not visible, click Office Button ➔ Word Options ➔ Popular ➔ Show Developer tab in the Ribbon ➔ Ok)
   - Word 2010: Located in the Macros section of the View tab
3. Select the appropriate macro (each macro contains a description of its function) and click Run.
Note: The template does not include macros for automatically generating other lists such as a List of Abbreviations or List of Graphs. However, it does include example lists that can be copied, pasted, and altered to meet your needs.

**Manually Formatting Your Document**

If you do not wish to use the template, you can still manually format your document. Below are basic instructions you may find useful while formatting your document. Please note that all Microsoft Word instructions are for Word 2007 or 2010.

**Creating a Single File from Multiple Files Using Microsoft Word**

Note: If you want to insert the header and footer also, be sure to insert the text from the file in a new section so that the header and footer are applied to only those pages.

In Word 2007 and 2010, the Insert File command has been renamed Text from File and moved to the Object menu on the Insert tab. Insert text from another file by doing the following:

1. Place your cursor at the point where you wish to insert the text.
2. On the Insert tab, in the Text group, click the arrow next to Object, and then click Text from File.
3. In the Insert File dialog box, locate the file you want to add and double-click it.

**Setting Section Breaks in Microsoft Word**

Section breaks allow you to format sections of your document independently from other sections. They are necessary when formatting page numbers and including both landscape and portrait-oriented pages.

1. Place the cursor at the point in your document where you wish to change your page formatting.
2. Click the Page Layout tab on the ribbon.
3. In the Page Setup section, click the Breaks icon.
4. Select Continuous. This creates a section break between the current and previous pages that will allow you to change the formatting in one section without affecting the other.

Formatting Page Numbers in Microsoft Word

Be careful that you set section breaks between front matter and body text and also between portrait and landscape-oriented pages. Each has a different way of formatting their pagination.

Front Matter

1. Set a continuous section break immediately before the Heading 1 on the first page following your approval pages.
2. Set a continuous section break immediately before the title of Chapter 1.
3. Open the footer on the first page following your signed approval pages by clicking the Footer button in the Header & Footer section of the Insert tab and selecting Edit Footer.
4. Deselect Link to Previous, located in the Navigation section of the Design tab. This step is only necessary for the first numbered page in the front matter.
5. Insert page numbers. Front matter page numbers should be in lowercase Roman numerals and should be centered at the bottom of each page.

Body Text

1. Open the footer of the first page in Chapter 1 of your document by clicking the Footer button in the Header & Footer section of the Insert tab and selecting Edit Footer.
2. Deselect Link to Previous, located in the Navigation section of the Design tab. This step is only necessary for the first numbered page in the body text.
3. Delete the page numbers from the footer.
4. Open the header on the same page by clicking the Header button in the Header & Footer section of the Insert tab and selecting Edit Header.
5. Deselect Link to Previous, located in the Navigation section of the Design ribbon.
6. Insert alpha-numeric page numbers, starting with 1, into the upper right-hand corner of the pages.
Landscape Pages

When setting pages of your document to landscape orientation to accommodate large figures or tables, you must reformat their page numbers so that they will still be visible after binding.

1. Set section breaks to divide the landscape page from the other pages.
2. Open the landscape page’s header by page by double-clicking within the header.
3. Deselect Link to Previous, located in the Navigation section of the Design tab. You will need to repeat this step for the page following the landscape page.
4. Delete the current page number.
5. In the Header & Footer section, located under the ribbon’s Insert tab, click Page Number.
6. Place the cursor over Page Margins and when the option window appears, select Vertical, Right.
7. Highlight the text and format to match your body text’s size and font.
8. Right-align text and delete the word “Page.”
9. Click the Format tab on the ribbon.
10. In the Text section, click the Text Direction button twice (if using 2007). If using 2010, click the Text Direction button once and select Rotate all text 90°.

Creating Dot Leaders for Manual Table of Contents in Microsoft Word

1. Click Home. In the bottom-right corner of the Paragraph field there is an arrow button; click this arrow button. The Paragraph window will open.
2. Click the Tabs button. The Tabs window will open.
3. Type in the Tab Stop Position as 0.5.
4. Select Alignment/Left.
5. Select Leader/#1 None.
6. Select Set.
7. Type in Tab Stop Position as 1.0.
8. Select Alignment/Left.
9. Select Leader/#1 None.
10. Select Set.
11. Type in Tab Stop Position as 5.63.
12. Select Alignment/Left.
14. Select Set.
15. Type in Tab Stop Position as 5.89.
16. Select Alignment/Right.
17. Select Leader/#1 None.
18. Select Set.
19. Select OK.
20. In the document, type the heading title, hit space bar twice, press Tab twice, then type in the page number.

Generating an Automatic Table of Contents Using Styles in Microsoft Word

To create an automatic table of contents, you will first have to modify and apply styles to your headings.

Modifying Styles

1. Click the arrow in the lower right-hand corner of the styles section, located in the ribbon’s Home tab. A pop-out window will appear.
2. Right-click the Heading 1 option and select Modify.
3. Format the style to match the heading requirements listed in the “General Formatting Guidelines.” Additional font controls can be found by clicking the Format button in the window’s lower left-hand corner. Once your changes have been made, click Ok.
4. Repeat steps 1-4 for Headings 2 and 3.

*Note: Heading 3 may not initially appear in the pop-out window’s list of styles. If this is the case, click the Options button and in the Select Styles to Show field, choose All Styles.*

Applying Styles

The benefit to using styles is that you do not have to reformat every heading individually. Once the styles are created, all you have to do to format your text is the following:

1. Highlight a heading from your text.
2. Click on the appropriate style that you previously modified. The style will be applied instantly.
Generating an Automatic Table of Contents

After applying styles to every Heading 1, 2, and 3, you can create an automatic table of contents. Automatic TOC’s are easily updateable at any time by right-clicking and selecting Update Field.

1. Place the cursor at the point in your document where you wish to insert a Table of Contents.
2. Click on the References tab on the ribbon.
3. Click the Table of Contents button and select Insert Table of Contents. A new window will appear.
4. Click the Modify button. A pop-out window will appear.
5. Click Modify.
6. Adjust the TOC Style to match the normal body text formatting as listed in the “General Formatting Guidelines” in Chapter 2.
7. Click Ok.
8. Manually delete the title page, copyright page, approval pages, and the table of contents page from the TOC.

Note: Heading 1s will not appear in all caps in the TOC unless you manually type them out in all caps in the document.

Creating Bookmarks for Your PDF Files in Microsoft Word

Bookmarks allow readers to easily navigate through your document. In order to create them in Word, you must have applied Styles to your headings (instructions listed above).

2007

1. Click the Office button in the upper left-hand corner of the screen.
2. Place the cursor over Save As and select the pdf option.
3. Click the Options button.
4. Under the Include non-printing information section, check the box named Create bookmarks using.
5. Make sure that the Headings option is selected and click Ok.
6. Save the file.

**2010**

1. Click the File Tab
2. Click Save As
3. Select PDF from the Select File Type drop-down menu.
4. Continue with steps 3-5 of the 2007 instructions.

*Note: When saving the file in Word 2010, in the Optimize for section, select the Minimum size (publishing online) option. This creates a smaller file and allows your document to load more quickly when readers open it on ScholarWorks.*

**Creating a Single File from Multiple Files Using Acrobat Adobe Professional**

In Adobe Acrobat Pro, merge files into a single PDF by clicking File, Create PDF, then Merge Files into a Single PDF.
CHAPTER FOUR: SCHOLARWORKS THESIS AND DISSERTATION

REFERENCE MANUAL

Note: A review copy of your thesis/dissertation CANNOT be submitted until after you have incorporated all requested changes by your committee after your defense, and after your advisor has signed the Final Reading Approval form.

Note: The Thesis and Dissertation Office will not start reviewing your thesis/dissertation until they have received: 1) Defense Committee Approval form; 2) Access Agreement for a Thesis or Dissertation; and 3) Final Reading Approval form.

ScholarWorks-Based Review and Final Submission Process

Below are the basic steps in the Thesis/Dissertation Review and Final Submission process via ScholarWorks.

1. Submit your electronic review copy in ScholarWorks.
2. Review feedback and requested changes provided by the Thesis and Dissertation Office.
4. If final document is accepted, pay binding fee and ensure order request for thesis/dissertation copies has been submitted to the Thesis and Dissertation Office.

If final document is not accepted, make requested changes and resubmit revision in ScholarWorks.

Getting Started: Creating a ScholarWorks Account

There are two main reasons you will need to create a ScholarWorks account. One is that you might want to share some of the research you have currently been working on for your department/field, in which case you advisor may ask you to create an account to
house your research. The main reason, however, will be as part of the thesis and
dissertation process: when you need to upload your electronic review copy of your

Creating a ScholarWorks Account

1. Go to the following website: http://scholarworks.boisestate.edu/
2. Click My Account. The Login/Create New Account screen will open.

![Figure 4.1 Clicking the My Account link](image)

4. Fill out fields using current data. Use a non-BSU e-mail that you will refer to often. Click **Sign Up**.

5. A New Account page will request you to activate your ScholarWorks account through your e-mail. Go to your e-mail account.
6. Find the e-mail and activate the account by clicking the provided link. If needed, check your Spam folder for the activation e-mail.

Thank you for your interest in creating a free account in The Berkeley Electronic Press ("bepress") system. Academics, researchers, and site administrators use their bepress accounts to access a wide range of services, publications, institutional repositories, and research portals.

To confirm your account and resume your activity, please click here.

If you experience problems clicking the link above, copy the URL below and paste it into your browser:

http://scholarworks.boisestate.edu/cgi/myaccount.cgi?context=&cc=fystlc9c&login=1916796

Still having trouble logging in? Please email us at support@dc.bepress.com.

7. Clicking the activation link will bring you to the My Account main page of your new ScholarWorks account. You are now ready to upload your research or explore the dashboard.

For more information about the My Account page and features, see the next section.

To upload your review copy, see the “Uploading Thesis/Dissertation to ScholarWorks for Review” section below.

ScholarWorks My Account: Overview

The figure below provides a screenshot of the My Account main page. Details about basic features provided in the My Account main page are itemized below. For more information, contact the ScholarWorks librarian in the Albertson’s Library.
Edit Profile

Click **Edit Profile** to change your password, affiliation, or contact information.

For the purpose of your thesis and dissertation submission, ensure your affiliation is Boise State University. Only your name, affiliation, and e-mail address is needed.

Ensure the e-mail you list is an e-mail address you check frequently. We recommend not using your `name@u.boisestate.edu` account as you will not use this after you graduate.
This is the e-mail address to which all feedback and notifications will be sent regarding your thesis/dissertation while in the review and final submission process, as well as after your document is posted to the ScholarWorks database.

Once finalized, you will receive occasional e-mails from ScholarWorks regarding the number of times your document is being accessed by the public.

**Research Alerts**

Click **Research Alerts** to modify or save search options, or to modify your email preferences regarding whether or not you want to receive a copy of e-mail you send through your ScholarWorks account. This is recommended while your thesis/dissertation is in review. The searches are exclusive to the ScholarWorks database.

**Author Dashboard**

Click **Author Dashboard** to create a Selected Works site using bepress. You will need to login using the login information you use for entry into your ScholarWorks account. Please note that this is NOT the location to which you will upload your review copy or final thesis/dissertation.

The Selected Works site allows you provide access and gather statistics on selected works you have published in bepress journals. This also allows you a stable URL for your selected works that you can provide on your CV.

Please contact the ScholarWorks librarian for Albertson’s Library for more information.
Follow Management

Click **Follow Management** to modify the sites and journals you are following via your Author Dashboard and Selected Works page.

Author FAQ

Click the **Author FAQ** link to discover answers to Frequently Asked Questions you might have regarding ScholarWorks.

Submit Research

Click **Submit Research** to upload documentation to department pages, or to upload your electronic thesis/dissertation for review by the Graduate College.

DO NOT upload your revision of an already reviewed thesis/dissertation here. Please see the “Uploading Revision of Thesis/Dissertation to ScholarWorks” section below for instructions.

**Uploading Thesis/Dissertation to ScholarWorks for Review**

*Note*: Once you have uploaded your review copy, the Administrator will lock your document so no changes can be made while the document is under review.

The document type to upload electronically to ScholarWorks can be .doc, .docx, or .pdf. When you upload a .doc or .docx file, a .pdf will automatically be created. However, please note that the Coordinator of Theses and Dissertations will often use the .doc or .docx file in case any formatting changes will need to be made.

*Note regarding equations*: Upload a .pdf version of your thesis/dissertation if you have mathematical formula or equations, as the conversion process in ScholarWorks sometimes strips the formula/equation when converting the document from .doc/.docx to .pdf. In these cases, if the Thesis and Dissertation
Office notices needed format changes, they will request the .doc/.docx file to be sent via e-mail.

1. On your ScholarWorks My Account main page, click **Submit Research** on the bottom in the left navigation bar.

2. In the list, click **Boise State Theses and Dissertations**.
3. The Submission Instructions and Access Agreement page will appear. Please read this page carefully.

![Submission Instructions and Access Agreement page](Image)

**Figure 4.8** The Submission Instructions and Access Agreement page (1 of 2)
Figure 4.9 The Submission Instructions and Access Agreement page (2 of 2)

4. Once you have read the Submission Instructions and Access Agreement, ensure you have the necessary data to continue. Click the Agree check box and click Continue.


6. Click Submit. The Submission Metadata page will appear. Ensure the content is correct before logging out or continuing. If it is incorrect, click the Revise Submission button and fix the metadata.

Congratulations! You have submitted your review copy to the Graduate College Thesis and Dissertation page.

7. Click My Account to return to the My Account main page, and to view the status of your thesis/dissertation submission.
Figure 4.10  My Account main page with Thesis/Dissertation submission

Thesis/Dissertation Metadata Page: Detailed Instructions

This section provides detailed instructions and tips for completing the content on the Thesis/Dissertation Metadata page. This content serves as the metadata for your document, which will dictate how the item is cataloged and made searchable in ScholarWorks, WorldCat, and other online search engines (depending on the Access Agreement options you selected on your Access Agreement for a Thesis or Dissertation).

Title, Author, Defense Date fields

The title of the document should be exactly as your title appears on your title page of the thesis/dissertation, except it should be title capped in this Title field. The only exception is if the proper noun is a species name or a chemical notation.
The **author** name should be your official name in BroncoWeb, which should also be the name listed on the title page of your thesis/dissertation, as well as the signature/approval pages. This is also the name that will appear on your diploma.

Ensure the e-mail address listed is e-mail address you will use after your graduate; we do not recommend using the name@u.boisestate.edu address. This is the e-mail to which all correspondence through ScholarWorks will occur, including feedback from the Coordinator of Thesis and Dissertations. List only one e-mail address.

Also ensure that Boise State University is listed as the affiliation.

The **Date of the Final Oral Examination** should be the exact date you defended your thesis/dissertation. This should also be the same date you committee member signed your Defense Committee Approval form, and the date listed on your electronic approval page included in the e-copy of your thesis/dissertation.

Please note that this date is not the month listed on the title page of your thesis/dissertation. The month and year on the title page of your thesis/dissertation is the month and year of your graduation.
Degree Title, Department, and Advisor(s) fields

The **Degree Title** should be the exact name of the degree you will be receiving; this is also the degree title that appears on the title page of your thesis/dissertation, in BroncoWeb, and on your diploma. Ensure the correct spelling and inclusion of all words. Here are a few examples:

- Master of Fine Arts in Creative Writing
- Master of Science in Biology
- Doctor of Education in Curriculum and Instruction
### Degree Title

Name of the degree associated with the work as it appears within the work. (example: Masters in Operations Research)

<table>
<thead>
<tr>
<th>Title:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

### Department

<table>
<thead>
<tr>
<th>Department:</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
</tr>
</tbody>
</table>

### Major Advisor

<table>
<thead>
<tr>
<th>Major Advisor:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

### Second Advisor

<table>
<thead>
<tr>
<th>Second Advisor:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

### Third Advisor

<table>
<thead>
<tr>
<th>Third Advisor:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

Figure 4.12  The Thesis/Dissertation Metadata page: Degree Title, Department, and Advisor(s) fields

Select the appropriate **Department** from the drop-down menu.
Complete the **Advisor** fields based on the composition of your supervisory committee. If you have more members than can fit in the three available boxes, only list the chair of the committee. If you have co-chairs, list them both in the Major Advisor box. See the figures below for the correct format for the advisor(s) name(s).

*Note: Ensure the correct spelling of your advisor and committee members, including the inclusion of initials and appropriate degree and punctuation. To verify names, see the “Boise State University Graduate Faculty” listing in the Boise State University Graduate Catalog.*

![Figure 4.13 Format for professor name](image)

![Figure 4.14 Format for Advisor field if there are Co-Chairs](image)

**Keywords and Subject Categories Fields**

These fields are crucial and determine how your thesis/dissertation is catalogued in ScholarWorks and WorldCat, and how they are discovered by future readers. Ensure care in selecting these keywords and subject categories. As you are the expert of your thesis/dissertation, you and your advisor would have the best understanding of this data. Please note this information on your Access Agreement for a Thesis or Dissertation and consult with your advisor.
Figure 4.15 The Thesis/Dissertation Metadata page: Keywords and Subject Categories fields

In the Available: window of the Subject Categories section, drill-down to the appropriate subject, and click the appropriate subject. Then click Select to move the item to the Selected: window. To remove an item from the Selected: window, click the item and click Remove.
Abstract

Copy and paste the abstract from your thesis/dissertation and past it here. Review the abstract before continuing, ensuring paragraph breaks, italics, and notations are correct. This abstract should be exactly as it appears in your thesis/dissertation. Verify there are no typos or spelling/grammar errors.

**Figure 4.16  The Thesis/Dissertation Metadata page: Abstract**

Upload Full Text and Additional Files fields

Click the Upload file from your computer radio button. This will change the field to allow you to Browse to your file. Select the correct file to continue.

**Note regarding equations:** Upload a .pdf version of your thesis/dissertation if you have mathematical formula or equations, as the conversion process in ScholarWorks sometimes strips the formula/equation when converting the document from .doc/.docx to .pdf. In these cases, if the Coordinator of Theses and Dissertations notices needed format changes, he/she will request the .doc/.docx file to be sent via e-mail.
Click the Additional Files check box if there are additional files that will accompany your thesis/dissertation. This includes, for example, maps. Browse to the file and attach it.

![Figure 4.17 The Thesis/Dissertation Metadata page: Upload Full Text and Additional Files fields](image)

---

**Note:** You must include all things that are part of your thesis/dissertation for review by the Graduate College.

### Accessing Editor Feedback and Attached Documents

When the Thesis and Dissertation Office has completed the review of your thesis/dissertation, you will receive an e-mail notification indicating that the scanned/reviewed .pdf of your thesis/dissertation, the format review letter, and additional forms are available for you to download and review via ScholarWorks.

### Accessing Thesis and Dissertation Office Feedback and Attachments

1. Log on to your ScholarWorks account to enter the My Account Main page.
2. Note that the status of your thesis/dissertation has changed from “under review” to “revisions required.” Click the linked title of your thesis/dissertation.

Figure 4.18  My Account main page: Status of thesis indicates “revisions required”

3. The thesis/dissertation action page will open with the revision history. In the left navigation bar, click View Decisions.

Figure 4.19  Thesis/Dissertation action page: Clicking View Decisions

4. The Decision Letter Sent to Author field will appear at the bottom of the page. Under Subject, click the link to the manuscript decision.

Figure 4.20  Decision Letter Sent to Author field: Clicking manuscript link

5. The decision letter from the Thesis and Dissertation Office will appear. Click and download the attachments.

Note: If the Thesis and Dissertation Office has reformatted your thesis/dissertation, please download this file and make the requested changes in this document.
Uploading a Revision of the Thesis/Dissertation

1. To access upload the revision of your thesis/dissertation, logon to your ScholarWorks account to enter the My Account Main page.
2. Click the linked title of your thesis/dissertation.
3. In the left navigation bar of the thesis/dissertation action page, click **Revise thesis/dissertation**.

![Figure 4.21 Clicking Revise thesis/dissertation.](image)

4. In the Thesis/Dissertation Metadata and Submission page, upload the new file, then click **Submit**. The document will now return to the ScholarWorks inbox of the Thesis and Dissertation Office for review.
BIBLIOGRAPHY


APPENDIX A

Example Pages
TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXAMPLE TITLE PAGE</td>
<td>82</td>
</tr>
<tr>
<td>EXAMPLE COPYRIGHT PAGE</td>
<td>83</td>
</tr>
<tr>
<td>EXAMPLE CREATIVE COMMONS PAGE</td>
<td>84</td>
</tr>
<tr>
<td>EXAMPLE ELECTRONIC THESIS DEFENSE AND FINAL READING APPROVAL PAGE</td>
<td>85</td>
</tr>
<tr>
<td>EXAMPLE THESIS DEFENSE COMMITTEE APPROVAL PAGE</td>
<td>86</td>
</tr>
<tr>
<td>EXAMPLE THESIS FINAL READING APPROVAL PAGE</td>
<td>87</td>
</tr>
<tr>
<td>EXAMPLE ABSTRACT</td>
<td>88</td>
</tr>
<tr>
<td>EXAMPLE OF A DIFFERENT STYLE ABSTRACT</td>
<td>89</td>
</tr>
<tr>
<td>EXAMPLE TABLE OF CONTENTS</td>
<td>90</td>
</tr>
<tr>
<td>EXAMPLE TABLE OF CONTENTS [FOR ARTICLE-BASED DOCUMENT]</td>
<td>92</td>
</tr>
<tr>
<td>EXAMPLE TABLE OF CONTENTS [FOR MFA THESIS]</td>
<td>95</td>
</tr>
<tr>
<td>EXAMPLE LIST OF TABLES</td>
<td>96</td>
</tr>
<tr>
<td>EXAMPLE LIST OF FIGURES</td>
<td>97</td>
</tr>
<tr>
<td>EXAMPLE CHAPTER WITH EXAMPLE HEADINGS</td>
<td>98</td>
</tr>
<tr>
<td>EXAMPLE WORKS CITED LIST (MLA)</td>
<td>99</td>
</tr>
</tbody>
</table>
THE INFINITE QUANDRY OF MITOCHONDRIA FIXATION:
THE STORY OF DALLAS MAGEE

by
Name of Writer

A thesis
submitted in partial fulfillment
of the requirements for the degree of
Master of Fine Arts in Creative Writing
Boise State University

May 2010
Stephanie Stacy Starr

SOME RIGHTS RESERVED

This work is licensed under the Creative Commons Attribution-NonCommercial-NoDerivs 3.0 United States license. To view a copy of this license, visit http://creativecommons.org/licenses/by-nc-nd/3.0/us/ or send a letter to Creative Commons, 171 Second Street, Suite 300, San Francisco, California 94105, USA.
DEFENSE COMMITTEE AND FINAL READING APPROVALS

of the thesis submitted by

Stephanie Stacey Starr

Thesis Title: The Effect of Alien Spaceship Engines on the Thermal Convection of the Atmosphere During the Quaternary Period

Date of Final Oral Examination: 01 April 2009

The following individuals read and discussed the thesis submitted by student Stephanie Stacey Starr, and they evaluated her presentation and response to questions during the final oral examination. They found that the student passed the final oral examination.

Marie S. Curie, Ph.D. Chair, Supervisory Committee
H. Rudolf Hertz, Ph.D. Member, Supervisory Committee
James Clerk Maxwell, Ph.D. Member, Supervisory Committee

The final reading approval of the thesis was granted by Marie S. Curie, Ph.D., Chair of the Supervisory Committee. The thesis was approved for the Graduate College by John R. Pelton, Ph.D., Dean of the Graduate College.
DEFENSE COMMITTEE APPROVAL

of the thesis submitted by

Stephanie Stacey Starr

We have read and discussed the thesis submitted by student Stephanie Stacey Starr, and we have evaluated her presentation and response to questions during the final oral examination. We find that the student has passed the final oral examination. The thesis is satisfactory for a master’s degree and ready for any final modifications that we may explicitly require.

Date

Marie S. Curie, Ph.D.
Chair, Supervisory Committee

Date

H. Rudolf Hertz, Ph.D.
Member, Supervisory Committee

Date

James Clerk Maxwell, Ph.D.
Member, Supervisory Committee
BOISE STATE UNIVERSITY GRADUATE COLLEGE

FINAL READING APPROVAL

of the thesis submitted by

Stephanie Stacey Starr

To the Graduate College of Boise State University:

I have read the thesis of Stephanie Stacey Starr in its final form and have found that (1) the modifications required by the defense committee are complete; (2) the format, citations, and bibliographic style are consistent and acceptable; (3) the illustrative materials including figures, tables, and charts are in place; and (4) the final manuscript is ready for submission to the Graduate College.

_____________________________________________  __________________________________________
Date                                         Marie S. Curie, Ph.D.
                                             Chair, Supervisory Committee

Approved for the Graduate College:

_____________________________________________  __________________________________________
Date                                         John R. Pelton, Ph.D.
                                             Dean of the Graduate College
ABSTRACT

This is an example sentence. This is another example sentence that follows the sentence before this one. This is another example sentence. Another sentence will follow, which will also be an example, demonstrating what another sample sentence could look like. Here is another example sentence.

This is an example sentence. This is another example sentence that follows the sentence before this one. This is another example sentence. Another sentence will follow, which will also be an example, demonstrating what another sample sentence could look like. Here is another example sentence.
ABSTRACT
The Effect of Alien Spaceship Engines on the Thermal Convection of the Atmosphere During the Quaternary Period
Stephanie Stacey Starr

This is an example sentence. This is another example sentence that follows the sentence before this one. This is another example sentence. Another sentence will follow, which will also be an example, demonstrating what another sample sentence could look like. Here is another example sentence.

This is an example sentence. This is another example sentence that follows the sentence before this one. This is another example sentence. Another sentence will follow, which will also be an example, demonstrating what another sample sentence could look like. Here is another example sentence.
# TABLE OF CONTENTS

ABSTRACT .................................................................................................................. iii

LIST OF TABLES .......................................................................................................... vi

LIST OF FIGURES ....................................................................................................... vii

LIST OF ABBREVIATIONS ....................................................................................... ix

CHAPTER ONE: HE SPOKE IN LONG SENTENCES ............................................. 1

Introduction .............................................................................................................. 1

The Way of the World ............................................................................................. 3

The Upward Stance of Dallas Magee ................................................................. 5

The Sideways Stare of Dallas Magee ................................................................. 7

The Downward Spiral of Dallas Magee .............................................................. 11

The Other Side of the World ................................................................................. 15

Here He Comes Again: The Long Drive Home .............................................. 18

CHAPTER TWO: HE DRANK THE SKY ................................................................. 27

Over the Malice Tree ............................................................................................... 38

What Long Teeth You Have: The Critical Response to Magee ...................... 42

The Post-Modern Approach ................................................................................. 47

The Pre-Post-Modern Approach ....................................................................... 52
CHAPTER THREE: CONCLUSIONS ................................................................. 62

WORKS CITED .......................................................... 75
TABLE OF CONTENTS [FOR ARTICLE-BASED DOCUMENT]

DEDICATION ........................................................................................................................................ iv

ACKNOWLEDGEMENTS ..................................................................................................................... v

ABSTRACT ........................................................................................................................................ vii

LIST OF TABLES ............................................................................................................................... xv

LIST OF FIGURES ............................................................................................................................ xvii

LIST OF ABBREVIATIONS ................................................................................................................. xxii

CHAPTER ONE: INTRODUCTION ..................................................................................................... 1

1.1 Graphite in Nuclear Reactor Applications ................................................................................. 2

1.2 Need for Characterization of Candidate Nuclear Graphites ..................................................... 2

1.2.1 Irradation-Induced Property Change .................................................................................... 3

1.2.2 Bulk Microstructure Change ................................................................................................ 4

1.3 Oxidation of Nuclear Graphite .................................................................................................. 5

1.3.1 Significance of Carbon Combustion ...................................................................................... 5

1.3.2 Graphite Oxidation in Nuclear Reactors .............................................................................. 5

1.3.3 Complications in Determining a Graphite-Oxygen Gas-Solid Reaction Rate ..................... 6

1.3.4 Approach to Nuclear Graphite Oxidation .............................................................................. 10
TABLE OF CONTENTS [FOR MFA THESIS]

DEDICATION ............................................................................................................ iv

ACKNOWLEDGEMENTS ........................................................................................ v

ABSTRACT ............................................................................................................... vii

BLUE RIBBON ........................................................................................................... 1

MACDO ................................................................................................................... 11

SACROMONTE ......................................................................................................... 31

CALLING THROUGH THE HALLOW ................................................................... 52

THE REASONS WHY ............................................................................................... 73

INTERSTATE ............................................................................................................ 97

THE DOWN ............................................................................................................... 110

THE HARVEST QUEEN .......................................................................................... 129
LIST OF TABLES

Table 1.1  Summary of environmental and body condition variables explored as they relate to migratory orientation and restlessness in Flammulated Owls and Northern Saw-whet Owls .............................................. 45

Table 1.2  Results of a negative binomial generalized linear model describing the relationship between migratory restlessness in Northern Saw-whet Owls and a variety of environmental and body condition variables ......................................................... 47

Table 1.3  ETC. ........................................................................................................ 52
<table>
<thead>
<tr>
<th>Figure</th>
<th>Caption</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1</td>
<td>This Is the Figure Caption for Figure 1</td>
<td>4</td>
</tr>
<tr>
<td>Figure 2</td>
<td>This Is the Figure Caption for Figure 2</td>
<td>12</td>
</tr>
<tr>
<td>Figure 3</td>
<td>This Is the Figure Caption for Figure 3</td>
<td>14</td>
</tr>
</tbody>
</table>
CHAPTER ONE: CHAPTER HEADING 1 HEADING

Heading 2

Heading 3

Heading 4

Heading 5. The paragraph keeps going from this same line.
WORKS CITED


APPENDIX B

Common Mistakes Observed During Format Review

and Editing Marks Used on Format Review
Common Mistakes Observed During Format Review

- Headings, Figure Captions, Table Captions, etc do not match those items listed in the Table of Contents, the List of Figures, the List of Tables, etc.
- Incorrect student name: Name must match the student’s primary name in My.BoiseState.
- Incorrect degree title: Must be the same as title in catalogue
- Incorrect graduation date: Should be one of three choices plus the graduation year: December, May, or August. Do not list season.

Reasons a Document May Be Rejected During Format Review

- The standards and guidelines for thesis/dissertation formatting are not followed
- Citations are incorrect beyond what is reasonable

Reasons a Document May Be Returned After Final Copy Submission

- Incorrect Defense Committee Approval Pages or Final Reading Approval Pages; errors on these pages, or printed on incorrect paper: there must be 3 official copies of each of these signed forms printed on 25% cotton paper.
- Incorrect student name listed
- Incorrect degree title listed
- Incorrect font and font size
- Poor electronic copy

Editing Marks Used by the Thesis/Dissertation Coordinator on Review Copies

See the following pages for examples of common editing marks and their definitions.
<table>
<thead>
<tr>
<th>Mark</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>EN</strong>:</td>
<td>editor note</td>
<td><strong>EN</strong>: Clarify this sentence.</td>
</tr>
<tr>
<td>---</td>
<td>indicates where an edit is located, or to which section a note/comment refers</td>
<td>The west expanded over the next eighteen years to include parts</td>
</tr>
<tr>
<td>✓</td>
<td>the reference or citation has been matched to the same item in the references list, and vice versa.</td>
<td>(Potts, Morgan, &amp; O’Daniel, 2009)</td>
</tr>
<tr>
<td>❌</td>
<td>verify content: spelling is incorrect, typo, or the reference is missing from the References list.</td>
<td>(Potts, Morgan, &amp; O’Daniel, 2009)</td>
</tr>
<tr>
<td></td>
<td>delete</td>
<td>Alexander the Great fought</td>
</tr>
<tr>
<td>^</td>
<td>insert</td>
<td>The mortality rate was 6.2% for</td>
</tr>
<tr>
<td>ู่</td>
<td>insert hyphen</td>
<td>The freeze-dried icecream</td>
</tr>
<tr>
<td>↑</td>
<td>insert comma</td>
<td>oranges, apples, and bananas.</td>
</tr>
<tr>
<td>่</td>
<td>insert period</td>
<td>Smith et al. determined that</td>
</tr>
<tr>
<td>่</td>
<td>insert colon</td>
<td>which included the following</td>
</tr>
<tr>
<td>่</td>
<td>insert semi-colon</td>
<td>Willard et al., 2011, McNell et al., 2003</td>
</tr>
<tr>
<td></td>
<td>insert space</td>
<td>In January 2011, eighteen large</td>
</tr>
<tr>
<td>( )</td>
<td>insert parenthesis</td>
<td>Jerome et al. (1884) continued to note</td>
</tr>
</tbody>
</table>

(see other side →)
<table>
<thead>
<tr>
<th>/</th>
<th>lowercase</th>
<th>Between 1901 and 1964, millions of ants</th>
</tr>
</thead>
<tbody>
<tr>
<td>≤</td>
<td>uppercase</td>
<td>the United States of America</td>
</tr>
<tr>
<td>N</td>
<td>switch places</td>
<td>more sense this would make</td>
</tr>
<tr>
<td>→ [</td>
<td>indent one TAB space</td>
<td>→ Heading 2 in Table of Contents</td>
</tr>
<tr>
<td>→ [</td>
<td>indent two TAB spaces</td>
<td>→ Heading 3 in Table of Contents</td>
</tr>
<tr>
<td>← [</td>
<td>un-indent one TAB space</td>
<td>← CHAPTER HEADING IN TOC</td>
</tr>
<tr>
<td>← [</td>
<td>un-indent two TAB spaces</td>
<td>← CHAPTER HEADING IN TOC</td>
</tr>
</tbody>
</table>
APPENDIX C

Sample Permissions Letters
Sample Permission Letter for Contributing Authors of Article

Name
Address
Phone

Date:

Dear _____________:

I am writing to request permission to use the article “[article title],” which was published in journal Name, volume X(N), on [date], for which you were a contributing author, in my thesis/dissertation.

I will include acknowledgements and/or appropriate citations to the work and copyright and reprint rights in the appendices. The bibliographic citation will appear in the References list at the end of the manuscript as typed below. Please advise me of any changes you require.

Please indicate your approval of this request by signing in the space provided, attaching any forms or instructions necessary to confirm permission. If you charge a reprint fee for use of your material, please indicate that as well. If you have questions, please call me at the number above.

I hope you will be able to reply immediately. If you are not the copyright holder, please forward my request to the appropriate person or institution.

Thank you for your cooperation,

[your name]

I hereby give permission to [your name] to reprint the following material in his/her thesis/dissertation.

(Description: Full bibliographic information, including specific page numbers and specifications [table numbers, figure numbers, direct quotations of lines, etc.].)

Signed: __________________________________________

Date: ________________
Sample Permission Letter: Request to Use Someone Else’s Work

Name
Address
Phone

Date:

Dear _____________:

I am currently completing my thesis/dissertation in the [name of department] at Boise State University. I hope to complete in the [fall, spring, summer] of [year].

I am writing to request permission to use the material acknowledged below in my thesis/dissertation.

I will include acknowledgements and/or appropriate citations to the work and copyright and reprint rights in the appendices. The bibliographic citation will appear in the References list at the end of the manuscript/chapter as typed below. Please advise me of any changes your require.

Please indicate your approval of this request by signing in the space provided, attaching any forms or instructions necessary to confirm permission. If you charge a reprint fee for use of your material, please indicate that as well. If you have questions, please call me at the number above.

I hope you will be able to reply immediately. If you are not the copyright holder, please forward my request to the appropriate person or institution.

Thank you for your cooperation,

[your name]

I hereby give permission to [your name] to reprint the following material in his/her thesis/dissertation.

(Description: Full bibliographic information, including specific page numbers and specifications [table numbers, figure numbers, direct quotations of lines, etc.].)

Fee ________________________________

Signed: ________________________________

Date: _________________
Sample Permission Letter to Request Journal Copyright Release

Name
Address
Phone

Date:

Dear ____________:

I am currently completing my thesis/dissertation in the [name of department] at Boise State University. I hope to complete in the [fall, spring, summer] of [year].

An article, [title of article], of which I am the first author, and which appeared in your journal ([date of publication, volume, page numbers]) reports an essential part of my thesis/dissertation research. I would like permission to reprint it as a chapter in my thesis/dissertation. (Reprinting the chapter may necessitate some revision.) Please note that Boise State University uploads an electronic version of the thesis/dissertation in an institution repository called ScholarWorks.

I will include an acknowledgement to the article on the first page of the chapter, as shown below. Copyright and permission information will be included in the appendices. If you would like a different acknowledgement, please so indicate.

Please indicate your approval of this request by signing in the space provided, and attach any other form necessary to confirm permission. If you charge for a reprint fee for use of an article by the author, please indicate that as well.

If you have questions, please call me at the number above or send me an e-mail message at the above address. Thank you for your assistance.

Best Regards,

[your name]

I hereby give permission to ______[your name]__________ to reprint the requested article in his/her thesis/dissertation, with the following acknowledgement:

(Acknowledgement, including full bibliographical information, including title, journal, volume, date, and page numbers.)

Signed: __________________________________________________________

Date: ______________

Fee: ______________
INDEX

Abbreviations

List of ........................................... 52, 57

Abstract .............................................. 4, 32

Example ....................................... 93–94

Access Agreement

Thesis ................................................. 10

Acknowledgements................................ 31

Alignment

Block quotes ........................................ 38

Figure captions ................................... 42

Figures ................................................ 42

Headings ............................................ 36

Table captions .................................... 44

Tables ................................................. 44

Text .................................................... 37

APA................................................. See Citations

Appendix................................................ 34

Example ............................................. 85

Figure/Table captions........ See Captions

Page numbers ........ See Page Numbers

Styles.................................................. 53

Approval Pages

Styles.................................................. 53

Thesis defense ..................................... 5, 9

Thesis final reading ......................... 5, 10

Audio Files...................... See Multimedia

Autobiographical Information ................. 32

Bibliography ......................... See Citations

Block Quotes................................. 38

Bookmarks................................. 62–83
Final Reading

Thesis process .................................. 5–6
Font ........................................................ 37
Footnotes .......................................... 43, 47

Format Review

Thesis ............................................... 6–7
Formatting .............................................. 18
Alignment .................... See Alignment
Block quotes....................................... 38
Bullet lists .......................................... 39
Cross-references............................... 39
Figure captions ................................... 42
Figures................................................ 41
Font .................................................... 37
Footnotes............................................... 43
General guidelines ....................... 35–37
Headings ............................................ 36
In template .................... See Template

Margins ............................................... 35
Microsoft Word instructions .......... 57
Notes .................................................. 40
Number lists ........................................ 41
Page numbers ........................................ 35
Paragraph .......................................... 37
References ..................... See Citations
Spacing ................................ See Spacing
Styles .................................................. 53
Table captions ..................................... 44
Tables ................................................. 44
Title page ........................................... 25–28
With attached template ............... 53
Forms

Required thesis forms ....................... 9–10

Graphs

List of ........................................... 52, 57
Headings ............................................. 36
Creating bookmarks ..................... 62–83

**Example page** ................................. 103

Styles.................................................. 53

To include in table of contents........... 33

Images ................................. *See Figures*

Library Services ....................... 15–17

Library Workshops

  Thesis Writing Assistance................. 17

List of Abbreviations ................... 52, 57

List of Figures ................................. 33

Example ................................. 102

Inserting automatically with template 56

Replacing in template ................. 51

List of Graphs ................................. 52, 57

List of Maps ................................. 52, 57

List of Photos ................................. 52, 57

List of Pictures ................................. 52, 57

List of Plates ................................. 52, 57

List of Symbols .............................. 52, 57

List of Tables ................................. 33

Example ........................................... 101

Inserting automatically with template 56

Replacing in template ........................ 51

Maps ................................. *See Multimedia, See Figures*

List of ........................................... 52, 57

Margins .................................................. 35

Manually formatting landscape pages

................................. 51, 56, 59

Microsoft Word

Instructions ................................. 49–83

Styles ................................. *See Styles*

MLA ................................. *See Citations*

Multimedia ................................. 47–48

Music Files ................................. *See Multimedia*

Navigation ................................. *See Bookmarks*

Notes ...................................................... 40
Styles

Applying in template...................... 50
Formatting in attached template........ 53
Modifying .................................... 60–61
Required when attaching the template
.................................................. 53–54
Required when working in template.. 50
Using styles to generate an automatic
table of contents ......................... 62
Survey of Earned Doctorates .......... 12

Symbols

List of........................................... 52, 57
Table of Contents............................. 33
Example ...................................... 95, 97, 100
Generate automatically ................. 60–62
Inserting automatically with attached
template....................................... 56
Manual dot leaders....................... 60
Replacing in template ..................... 51

Thesis

Format review .............................. 6–7
Title Page ................................. 25–28
Example ..................................... 87
Style ........................................... 54
Video Files .............................. See Multimedia

Style ........................................... 54
Tables .......................................... 44
Captions ................................. See Captions
List of ................................. See List of Tables
Template ...................................... 49
Attaching ..................................... 54
Downloading ............................. 50
Styles ...................................... 50, 53
Table of contents and list of
figures/tables ........................... 51, 56
Using with a preexisting document... 53
Writing a document within ............. 50